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Chapter 1:  
DataNet Overview 

1.1. DataNet Introduction 

The Wireless Intelligent Logging Network 
Fourier Systems next generation data logging system is the 
DataNet, a 16-bit, mobile data acquisition network based on 
innovative ZigBee technology. This solution provides an 
intelligent sensor mesh system with 100% data receipt and no 
data loss.   
The DataNet system is comprised of data logging units with 
graphic display and four inputs for direct measurement and 
recording of PT-100, thermocouple, 0-1 V, 4-20 mA, 
frequency and pulse sensors, as well as two internal 
temperature and relative humidity sensors. Data is transmitted 
from these units to a Receiver connected to a central 
computer. The system leverages the ZigBee protocol, a 2.4 
GHz license-free frequency RF band, to ensure full data 
integrity. By adding DataNet Repeater units to the network, 
you can form a reliable mesh network of up to 65,000 units. 
With its high resolution and fast Analog to Digital converter 
(ADC), DataNet data loggers meet the majority of data 
acquisition requirements in most industrial applications. Every 
DataNet logger unit is embedded with a unique serial number 
and can be loaded with a descriptive comment for safe 
identification. An internal clock and calendar keep track of the 
time and date of every sample measured. 
DataNet loggers can automatically activate external alarm 
events when data is outside a specified range. e-mail and 
SMS notifications can be sent to predefined contacts. 
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The DataNet system is powered by the powerful DataNet 
software. The Windows ™ based software is the central 
management interface of the DataNet network. Data is 
monitored online and can be displayed in graphs or tables. 
You can analyze data with various mathematical tools, or 
export data to a spreadsheet.  
The software also enables you to configure, calibrate or 
update the firmware of DataNet units wirelessly.  

Key DataNet benefits include: 
• Reliable transmission ensuring no data loss 
• Long range monitoring 
• Ability to constantly expand transmission range by adding 

additional Repeaters 
• Portable units facilitating easy deployment in various 

environments 
• Remote programming and firmware updates  
• 65,000+ possible end units 
• 16-bit resolution 
• Low power consumption 
• Long battery life 
• Minimal costs thanks to wireless infrastructure 

1.2. What is ZigBee? 

ZigBee is a standards-based protocol built around the IEEE * 
802.15.4 wireless protocol, providing the network 
infrastructure required for wireless, low power network 
applications.  
* IEEE is the Institute of Electrical and Electronics Engineers, 
a non-profit organization dedicated to furthering technology 
involving electronics and electronic devices. 
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1.3. The ZigBee Concept 

• The Coordinator: There is only one Coordinator in a 
ZigBee network. 
Its job is to form and maintain the network.  

• The Router: A router can relay messages between units 
and by that increase the distance between units in the 
network.  

• The End Unit: A simple sensor unit, usually, battery 
operated. A ZigBee End unit cannot relay messages.  

ZigBee Terminology DataNet Terminology 
Coordinator Receiver 
Router Repeater 
End Unit Data Logger 
 
ZigBee enables mesh networking which supports a wireless, 
yet integrated environment with communication between 
many coordinators, routers and end units in environments 
where multiple applications are being monitored.  

1.3.1. ZigBee Mesh Network 
Operation 

 

 
Figure 1: ZigBee network diagram 
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In a mesh network, all the router units are aware of their 
environment meaning a router knows with units are close by. 
When a router sends a message to a specific unit, it relays the 
message until it gets to the destination. 
Network recovery from a unit failure 
In a mesh network, when a router fails, the network 
automatically finds a different path via a different router for the 
message relay. 
This ensures maximum protection against a network 
breakdown. 

1.3.2. Why is ZigBee Technology Key 
for Data Logging? 

ZigBee technology has proved to be ideal for data acquisition 
networks which require meter reading, parametric display of 
data such as temperature or humidity and responsive action 
when parameters are crossed. This is due to the fully 
automated, flexible and reliable nature of the protocol. With 
the Mesh Network system, the ZigBee standard redresses 
misbalances in any data logging system, responding to 
weaknesses, inefficiencies, new network structure (with the 
additional or removal of devices) through self correct.  

1.4. The DataNet System  

The basic DataNet order will contain at least one of the 
following units: 
• DataNet data logger – either DNL910 or DNL920, or both 
• Receiver/Repeater unit  
• Mini-USB cable 
• Power adapter (one per DataNet unit ordered) 
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• DataNet Software CD (containing software and user 
guide) 

• DataNet user guide  

1.4.1. The Data Logger  

The so-called end unit of the DataNet system, the data logger 
can connect to up to four external sensors and has either one 
internal temperature sensor or one internal temperature and 
one humidity sensor, depending on the specific model. Data is 
recorded and stored to the logger’s internal memory and 
transmitted over the network to the DataNet software running 
on the PC.  
The data logger is programmed to consume as little power as 
possible during operation, in order to conserve the battery life. 
When not transmitting or recording data the units are in sleep 
mode and they wake up when needed.  
The battery is rechargeable and can run up to four months on 
one charge, at a sampling rate of one sample every five 
minutes and transmission rate of once every ten minutes.  

Note: Battery life depends on the logger sampling rate, 
transmission rate, type of sensor, network architecture and 
number of measured sensors. 
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Part Number: DNL920 Part Number: DNL910 
Four channel data logger with two 
internal sensors, Humidity and 
Temperature. 

Four channel data logger with 
internal Temperature sensor. 

Transmission Range: Up to 80 
m line of sight 
Memory Capacity: ~60,000 
samples 

Transmission Range: Up to 80 
m line of sight 
Memory Capacity: ~60,000 
samples 

1.4.2. The Receiver/Repeater  

The Receiver/Repeater unit can be programmed by the user 
to work in either mode. 
The Receiver acts as a bridge between the DataNet network 
and the PC. It is connected to the PC via USB cable and is 
used to create the network to which you add your data 
loggers. The Receiver is externally powered but also includes 
a rechargeable battery for back up (in case the external power 
fails). 

Note: Each Receiver can detect up to 8 data loggers. To 
detect more data loggers, Repeaters are required. 
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The Repeater is externally powered but also includes a 
rechargeable battery for back up (in case the external power 
fails). These units are considered the backbone of the 
network, as they enhance the network range by receiving and 
transmitting the data from Repeater to Repeater until the data 
reaches the designated end unit or the PC. 
The Repeaters are the end units’ parent units, meaning each 
Repeater has specific end units under their responsibility 
(their children). They route the transmissions to and from the 
end units to the Receiver (or other Repeaters in the network).  
Each Repeater holds the data sent to the end units while the 
end units are in sleep mode. At a specific interval the end unit 
wakes up and receives the data from its parent (Repeater). 

Note: Each Repeater can detect up to 24 data loggers. If the 
number of loggers exceeds this capability, additional 
Repeaters are required. 

 

Part Number: DNR900 
Repeater Transmission Range: 800 m line of sight 
End Units per Receiver: ~65,000 
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1.4.3. Hardware Accessories 

The DataNet system includes the following accessories: 
• Mini-USB cable for connecting PC to DataNet Receiver 
• Power adapter to power DataNet Receiver, Repeater and 

data loggers 

1.4.4. DataNet Software  

The user interface for the DataNet system, the DataNet 
software CD is provided together with the DataNet hardware 
and includes the following features: 
• Network management 
• Data display, management, storage and data diagnostics 
• Alarm settings: e-mails and SMS notifications, visual and 

audible alarms. 
• Wireless sensor definition  
• Wireless sensor calibration  
• Wireless firmware update (boot over the air) 

 
The software interface is described in detail in Chapter 4 of 
this user guide. 
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Chapter 2:  
DataNet Quick Start 
Guide  

Fourier Systems strongly suggests first time users of the 
DataNet system read this chapter before drilling down into the 
many features of the system described later in the user guide. 
The Quick Start Guide will give you a clear understanding of 
the basic aspects of setting up the system, and getting your 
network up and running.  
Once you are familiar with the technical aspects of setting up 
the network as outlined in this chapter, please consult section 
 2.8 on page 23 for Fourier’s recommended approach to initial 
deployment of the system. 

2.1. Launching the Software 

1. Install the DataNet software on the PC workstation. Refer 
to section  4.1: Installing DataNet Software on page 56 for 
more details. 

2. Once the software and associated components have 
been installed, launch DataNet from your DataNet 

desktop shortcut . 
3. The main DataNet window is launched. The default view 

is called Map View. 
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Figure 2: Main DataNet window 

2.2. Connecting the Receiver 

1. Connect the DataNet Repeater unit (DNR900) to the 
Fourier-supplied power adapter.  

Note: Only use adapters provided by Fourier Systems. Use of 
the wrong adapter could damage your DataNet units.  

 

2. Turn on the unit by pressing the Scroll button  on 
the front keypad. The unit will beep when turned on. 

3. The LCD screen will prompt you to select either Receiver 

or Repeater. Press the Enter button  to configure 
this unit as a Receiver, as this unit will be connected to 
the computer and will be used to form the DataNet 
network.  
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4. The unit will be configured as a Receiver and it will create 
a network. The message Network is up will be displayed 
on the screen, and then the Receiver’s default unit name, 
Fourier Systems, will appear.  

5. Connect the USB cable to the computer and to the 
Receiver’s mini-USB port. The DataNet Receiver icon 

 will immediately appear in the top left corner of the 
Map View. 

 
Figure 3: Adding Receiver icon to Map View 

 
A green icon indicates that the Receiver is online. Should 
you disconnect the Receiver’s USB cable or power 
adapter (and the battery eventually dies), the Receiver 

icon will be grayed out:   

Note: You can move the Receiver icon elsewhere on the 
screen by going to Tools > Lock Map View and unselecting 
this option. 

6. Check the DataNet network ID that was formed by the 
Receiver by placing the mouse cursor over the Receiver 
icon. The network ID as well as Receiver firmware version 
and unit serial number is displayed. 
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Figure 4: Receiver tooltip  

2.3. Adding the Data Logger to 
the Network 

Once you have connected your Receiver and established a 
network you are ready to add data loggers and build your 
system. 
1. Charge each of your loggers for up to 10 hours before 

use. A fully charged battery can last up to six months, with 
sample rate of once every five minutes.  

Note: Only use adapters provided by Fourier. Use of the 
wrong adapter will likely damage your DataNet units.  

2. Remove the logger from the power adapter and turn on 

the logger by pressing the Scroll button . The unit 
will beep when turned on. As soon as the unit is turned 
on, the LCD screen will display the following message: 

 
3. The logger will then start scanning for networks. The LCD 

will indicate how many networks were found in range, and 
will announce when the scan is complete.  

 

Fourier Systems 
DataNet Logger 
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Scan for network Scan for network 
Found 2 networks

Scan complete  Scan for network Scan for network 
Found 2 networks

Scan complete  

 
To join the network created by your specific Receiver (there 
may be other networks created by your colleagues) scroll 
through the found networks on the LCD (using the logger 

Scroll button) and press the Enter button  when you 
reach the required network. In the example below, the 
network required is the second network found. You can also 
rescan the networks by pressing Enter on the Rescan 
networks screen, which is reached by scrolling through all the 
found networks. 

Network 1:
ID: 014.061.082  

Network 2:
ID: 026.167.85  

Rescan networksNetwork 1:
ID: 014.061.082  

Network 2:
ID: 026.167.85  

Network 1:
ID: 014.061.082  

Network 2:
ID: 026.167.85  

Rescan networks

 
 
4. Once you select the network, the logger will automatically 

join that network and a new message will be displayed on 
the LCD: 

 
5. The LCD will then indicate the following status message: 

 

Fourier Systems 
Ready 

Joined to Network: 
ID: 026.167.85   
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If the Receiver is disconnected for any reason, the following 
message is displayed: 

 

6. When the logger joins the network, the Logger icon  
will automatically appear in the Map View.  

a. The  symbol indicates the signal strength of the 
logger in the network.  

b. The  symbol indicates that the logger is running 

from internal battery supply. The  symbol indicates 
that the logger is running from external power supply. 

c. The  symbol indicates that the logger is a new 
addition to the network and has not yet been 
configured (setup). 

Note: Load an image into DataNet showing a map of your 
facility in order to place the Receiver and Logger icons in their 
actual positions. As you add more loggers to the system, this 
will prove very helpful.  
Double click the Map View background to browse to the 
image directory. Remember to unlock the Map View in order 
to move the icons around. 

Fourier Systems 
No Receiver 
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Figure 5: Map View background image example 

2.4. Optimizing the Network 

When you first setup your network, you want to ensure that 
the loggers are placed in the optimum position in order to 
receive and transmit data to/from the DataNet software. 
Refer to the DataNet specifications to guide you on the range 
of the DataNet units. With this knowledge, and based on the 
layout of your facility, you should have a good idea of the 
likely positional layout of your units. 
Rather than setup the system on a trial and error basis, 
DataNet has a Signal Test utility built in to the logger 
firmware, which gives you a clear idea of the strength of the 
signal of each logger to the Receiver, and the quality of the 
data link between Receiver and logger. 
 
Perform the following test on each logger in your system while 
deciding where to position the logger: 
1. Using the Scroll button, scroll through the main menu on 

the logger until you reach the following display: 
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2. Press the Menu button to run the test. 

The signal level and link quality will be displayed. As you 
move the logger further away from the Receiver, you will 
see these two parameters drop from a maximum of 100%.  
When the logger is out of range of the Receiver, you will 
see the following screen: 

 
 
3. To exit the Signal test, press the Scroll button. 

2.5. Monitoring the Network 
Connections 

By going to Network > Show Network Paths in the DataNet 
main menu, the software will show the actual path that the 
system uses to communicate between Receiver and logger, 
for all units in the system. 

 
Figure 6: Showing network paths – Example 1 
 
You can also select Show Path from the logger context menu 
to display individual paths. 

Out of range 
 

Signal level: 
Run test -> Menu 
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Using this option you can see exactly how the system is built. 
As DataNet is built using mesh networking technology, you 
can add Repeaters (DNR900) to the system to enhance the 
network range. Loggers which aren’t in range of the Receiver 
can transmit to the Receiver via a Repeater which is in range.  

Note: The Receiver/Repeater is the same device, just 
configured differently from the main menu when turned on. 

 
Figure 7: Showing network paths – Example 2 
 
The screenshot above shows a system of three loggers (red 
circles) and two Repeaters (blue squares) transmitting to the 
Receiver. 
The arrows show the path between the units. Note that they 
are bi-directional, meaning that the system is a two-way 
system with units both transmitting and receiving data. 
• A green path indicates a strong signal 
• A yellow path indicate a medium strength signal 
• A red path indicates a weak signal 
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2.6. Configuring the Logger 

Once you connected your DataNet loggers to the network, 
you must configure them in order to start acquiring data. 
1. Right-click on the Logger icon you wish to configure. 

Select Setup from the context menu. 
The Setup window will be launched. 

 
Figure 8: Logger Setup window 

 
This dialog provides non-editable information such as the 
serial number, battery level, reception level and firmware 
version of the current unit.  
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On the Device Setup and Alarm Setup tabs, the user is 
able to configure the following parameters:  
 Unit's comment  
 Sampling rate  
 Transmission interval 
 Samples averaging  
 Temperature units °C/°F (also displayed on the 

loggers LCD) 
 Active sensors  
 Custom sensors' names  
 Alarm levels  
 Alarm duration  
 Alarm delay  
 Alarm pre delay 

2. Select the sensors you wish to connect to the logger for 
data acquisition. It doesn’t matter which order you select 
the sensors. You may only have Input 4 selected, for 
example, and Inputs 1 to 3 left unselected. 

3. Select the sampling rate and transmission interval (rate at 
which the data is transmitted from the logger to the 
Receiver). 

4. Unless you have Alarm levels you wish to edit (see the 
Alarms Setup tab), click either Setup and Run (to send 
the setup and immediately log data), or Setup Only (to 
send the setup but only log data at your command). 

5. If you selected Setup Only in step 4, right-click the 
Logger icon and select Run from the context menu to 
start logging data. 

6. To stop the logger, right-click the Logger icon and select 
Stop from the context menu. 
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Note: Running the logger clears the logger memory. All 
previously recorded data will be erased when you begin a new 
logging session. 

2.7. Viewing Data  

Once you run the logger, you have several ways of viewing 
the online data that is being acquired. 
• Online graph/table/statistics views 
• Logger icon tooltip 
• Sensor view 

2.7.1. Online Data Views 

Double clicking the Logger icon or selecting Display Data in 
the Logger icon context menu will open the online graph. 
This graph is updated in real-time with the newly recorded 
data. 
You can switch between Graph, Table and Statistics views to 
view the data in different formats.  

      
Figure 9: Online data – Graph view 
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Figure 10: Online data – Table view 
 

 
Figure 11: Online data – Statistics view (partial view of 
Statistics dialog) 

2.7.2. Logger Tooltip 

Close the online data window and return to Map View. Scroll 
over the Logger icon and you will see a tooltip displaying the 
relevant logger information, including real-time data.  
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Figure 12: Logger tooltip 
This tool-tip is updated with every newly recorded sample. 

2.7.3. Sensor View 

Click the Sensor View icon  in the tool bar to switch to 
this view. Here, you can monitor the data by viewing data 
display of each individual sensor, rather than of each logger. 

 
Figure 13: Sensor view 
 
• If the sensor is in alarm, the sensor box will change color 

from green to red (just as the Logger icon would). 
• Double-clicking the individual sensor window will open the 

data in the online Graph view. 

Note: By going to Tools > Switch Sensor View Mode you 
can reduce the size of the sensor window to display only the 
sensor type and sensor data. 
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2.8. Recommended Approach to 
Deploying DataNet Units 

Now that you have a general understanding of how the 
DataNet system functions, you may wish to use Fourier’s 
recommended approach for initial deployment of the system. 
This approach will ensure a smooth and efficient deployment 
of your DataNet units and you may then tweak this approach 
based on experience you gain while using the system.  

Note: When deploying the system bear in mind that several 
factors could cause interference with the system, such as 
electromagnetic pulses, metal shielding in the vicinity of the 
transmissions, other devices using the same 2.4 GHz band, 
etc. Be familiar with your environment before deploying the 
system. 

 
1. After you have charged the DataNet units and are ready 

to deploy them in your facility, collect all units - data 
logger end units, Receiver and Repeaters (if relevant) – 
and bring them to your PC workstation.  

2. Connect the Receiver to the PC and form a network. Turn 
on the units and one by one bring them online so you can 
view their icons in the DataNet software’s Map View. 

3. Configure each of the units via the Setup feature. At this 
stage it is not necessary to configure the type of sensors 
you will be using, or sample rate, alarm levels, etc. The 
point of this step is to configure each of the units with a 
logger or Repeater name that indicates where in your 
facility they will be deployed. For example, Room 15 
Freezer or Floor 2 Bio Lab. This will make it much easier 
for you to recognize the units in the Map View once you 
have deployed them. Once in place, you can reconfigure 
the units however you like.  
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4. It is also recommended, if possible, to change the Map 
View default background to a diagram or map of your 
facility. You can then move the logger or Repeater icons 
accordingly so you can have a visual representation of 
their location in the facility. 

5. Take each logger and begin to distribute in your facility in 
the precise location you would like them to be based. 
Once in position you can then run the Signal Test on each 
logger to verify that you have a good signal to the 
Receiver. If you are out of range and there is no 
alternative location for the logger, you will most likely have 
to add at least one Repeater to the network.  

6. Once each of the loggers is in position return to the PC 
and in Map View, verify that each of the loggers is online. 
You can also use the Show Network Paths feature to 
see the path of the logger to the Receiver, and the 
strength of the transmission.  

7. If you determine that you need to add Repeater/s to the 
network in order to bring end units online or enhance the 
transmission where the signal is weak, then deploy the 
Repeater/s with the following points in mind: 
a. There must be an electrical socket accessible at the 

location of the Repeater as they must be powered 
externally in order to run for more than a few hours. 

b. Place the Repeater/s as high from the ground as 
possible in order to enhance the wireless signal from 
its antenna.  

c. Expose the Repeater/s to as many end units as 
possible. For example, if there is a room with several 
offline end units requiring a Repeater, position the 
Repeater next to the room so that it is in range of as 
many of these end units as possible, so you don’t 
have to add more Repeaters.  
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8. After you have deployed the Repeater/s return to the 
software and using the Show Network Paths feature verify 
that all end units are now successfully transmitting to the 
Receiver, either on their own or via a parent Repeater. 
You can continue to tweak the position of the units until 
you are satisfied with the quality of the transmission. 

9. Now that the units are in place the last step of initial 
deployment is to reconfigure each unit to start data 
acquisition. Configure the sensor setup, sample rate, 
transmission rate, alarm levels, e-mail/SMS notifications, 
etc. as you see fit.  

 
 
 



 
 

26 

Chapter 3:  
Using the DataNet 
Hardware  

3.1. Data Logger Front Panel 
Layout 

Scroll button
Menu/Enter button

LCD screen

Scroll button
Menu/Enter button

LCD screen

 
Figure 14:  Data logger front panel 
LCD screen 
Displays logger status, logger data, Min/Max values and network 
information. 
Menu/Enter button 
Use to enter logger menu options and to execute logger 
commands. 
Scroll button 
Use to scroll though menu items and to power on unit. 
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3.2. Data Logger External 
Connections 

 

Mini USB port

12 V power socket 
Negative Center

Four sensor 
inputs

Excitation

Mini USB port

12 V power socket 
Negative Center

Four sensor 
inputs

Excitation

 
Figure 15:  Data logger external connections 
 
Mini USB Port 
Functional in future models only – to enable firmware update from 
PC via logger USB port. 
12 V Power Socket 
To connect logger to external power supply (negative center). 
Sensor Inputs 
Pluggable screw terminal blocks marked In-1 to In-4 (from left to 
right), to connect wide range of sensor types for data acquisition. 
All four inputs can be used simultaneously. Sensors can be 
connected in any order. 
To connect a sensor to the DataNet data logger, unplug the 
screw terminal, connect the sensor’s wires to the terminals, and 
then plug the terminal back to the corresponding socket on the 
input block. 
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Excitation socket 
Output power socket used to power external sensors, power 
derived directly from the external power supply adaptor.   

3.3. Receiver/Repeater Front 
Panel Layout 

Scroll button
Menu/Enter button

LCD screen

 
Figure 16:  Receiver/Repeater front panel 
LCD screen 
Displays Receiver/Repeater status and network information. 
Menu/Enter button 
Use to enter logger menu options and to execute logger commands. 
Scroll button 
Use to scroll though menu items and to power on unit. 
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3.4. Receiver/Repeater 
External Connections 

12 V power socket
Negative Center

External Alarm

Mini USB port

 
Figure 17:  Receiver/Repeater external connections 
Mini USB Port 
To connect Receiver to PC and be detected by DataNet software. 
Connect the mini USB Type B plug (rectangle plug) of the supplied 
USB communication cable to the Receiver and the USB Type A 
plug (flat plug) to the computer. 
Refer to section  3.8 on page 38.  
12 V Power Socket 
To connect unit to external power supply. Plug in an AC/DC 9-12 V 
adaptor to power the unit. To use as a Receiver or Repeater and 
maintain network integrity, the unit should be powered at all times. 
Connecting external power to the unit automatically charges the 
internal back-up battery. The adaptor should meet the required 
specifications – see  Chapter 4:  DataNet Specifications on page 
130. 
External Alarm 
Will be functional in future versions. 
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3.5. Data Logger Sensor 
Overview 

3.5.1. Internal Sensor Types 

The DNL910 and DNL920 loggers include internal sensors, 
depending on the logger model. 

Sensor Measurement 
Range 

Accuracy Logger 
Model 

Digital Humidity  5% to 95% 3% (in DataNet 
software) 
4% (on logger LCD) 

DNL920 

Digital Temperature -20 ºC to 50 ºC 0.5 ºC DNL920 
Temperature 
PT100  -20 ºC to 50 ºC 0.3 ºC  

DNL910 

3.5.2. External Sensor Types 

Each of the four input channels of the DataNet data logger is 
multi-purpose and can be individually configured to any of the 
following types and ranges.  

Sensor Measurement 
Range 

Accuracy Available 
Inputs 

Current  4 – 20 mA ± 0.5 % In-1 to In-4 
Frequency 20 Hz – 4 KHz N/A In-4 only 

Temperature 
PT100 (2-wire) -200 to 400 ºC 

-200 to -60 ºC ±0.5 % 
60 to 400 ºC ±0.5 % 
-60 to 60 ºC ±0.3 ˚C 

In-1 to In-4 
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Sensor Measurement 
Range 

Accuracy Available 
Inputs 

Temperature TC-J -200 ºC to 1,000 ºC 

-200 to -60 ºC ±0.5 % 
60 to 1,000 ºC ±0.5 
% 
-60 to 60 ºC ±0.3 ˚C 

In-1 to In-4 

Temperature TC-K -200 ºC to 1,000 ºC 

-200 to -60 ºC ±0.5 % 
60 to 1,000 ºC ±0.5 
% 
-60 to 60 ºC ±0.5 ˚C 

In-1 to In-4 

Temperature TC-T -200 ºC to 400 ºC 

-200 to -60 ºC ±0.5 % 
60 to 400 ºC ±0.5 % 
-60 to 60 ºC ±0.3 ˚C 

In-1 to In-4 

Pulse Counter 
1 – 65,536 pulses 
0 to 4 KHz N/A 

In-4 only 

Voltage 0 – 1 V ± 0.5 % In-1 to In-4 
Voltage 0 – 50 mV ± 0.5 % In-1 to In-4 

3.5.3. Sensor Connection 

Connect the sensor/s to the terminal block/s at the top of data 
logger: 

 
Figure 18: DataNet logger sensor inputs 
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Sensors do not have to be added successively. You may only 
configure In-4, or configure In-1 and In-3, for example, when 
setting up the logger via the software. 

3.5.4. External PT-100 Sensor 
Connection 

The PT-100 sensor as supplied by Fourier Systems comes 
pre-wired to the data logger’s terminal block.  
The PT-100 positive polarity (red) and ground (white) wires 
are connected to the + input of the terminal block. The 
negative polarity (black) wire is connected to the – input on 
the terminal block.  

3.5.5. Programming Limitations 

The standard sampling rate for all sensors on all inputs is from 
a maximum of one sample every second to a minimum of one 
sample every two hours. However, there are certain 
limitations using a specific combination of sensors, which 
must be taken into account when programming the DataNet 
data loggers.  

Note: The software integrates all programming limitations 
automatically when configuring the loggers.  

Please refer to the table below for DataNet programming 
limitations, where: 
PT100, Thermocouple J, K or T  = A 

Internal Digital Temperature (on DNL920) = B 
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Sensor 
Combination 

Maximum 
Sampling Rate 

Example Setup 

3 x A 
4 x A 
A + B 

One sample every 
two seconds 

In-1: PT-100 
In-2: TC-J 
In-3: TC-J 

(2 x A) + B 
(3 x A) + B 

One sample every 
three seconds 

Internal: Temp 
In-1: TC-T 
In-2: PT-100 

(4 x A) + B One sample every 
four seconds 

Internal: Temp 
In-1: TC-T 
In-2: TC-J 
In-3: PT-100 
In-4: PT-100 

Table 1: Data Logger programming limitations 

3.5.6. Alarm Output 

In-1 serves either as a standard sensor input or as an alarm 
output. Configure In-1 as a dry contact External Alarm 
(Normally Open or Normally Closed) via the logger Setup 
window in the DataNet software. 

3.5.7. Polarity 

Current, voltage, thermocouples and user defined sensors 
have distinct polarity. Be careful to connect them in the right 
polarity. 
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3.5.8. Frequency/Pulse Counter 

Connect the signal wires to In-4 terminal blocks, and select 
Frequency or Pulse counter for Input 4 from the logger 
Setup window in the DataNet software. Inputs 1 to 3 are still 
available for other sensors. 
 
The Frequency/Pulse counter is optically isolated from the 
internal circuitry and can simultaneously measure a signal 
source, together with another input. 

3.5.9. User Defined Sensors 

DataNet provides a simple and straightforward tool for 
defining a limited number of custom sensors. Almost any 
sensor or transducer with 0 – 1 V or 4 – 24 mA output is 
accepted by the DataNet logger and its electrical units are 
automatically scaled to meaningful user-defined engineering 
units. 
The sensor definitions are stored in the logger’s memory and 
are added to the sensors list. The sensor’s readings are 
displayed in the user defined units only in the DataNet 
software. Future versions will also support displaying the user 
defined units on the logger LCD as well. 
Refer to section  4.5.1 on page 75 for more details.  

3.5.10. Sensor Alarms 

Via the software, users can define minimum and maximum 
alarm levels for each input individually. Users can define pre-
low and pre-high alarm levels, for an additional level of safety 
in case the logger is approaching an actual breach of alarm. 
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The DataNet logger display indicates when the sensor reading 
is in alarm of any type. The symbols AL-H, AL-L, AL-P-H or 
AL-P-L are visible next to the corresponding input readings.  
Refer to section  4.12 on page 103 for more details. 

3.5.11. Sensor Calibration 

The DataNet data logger is shipped fully calibrated. However, 
further calibration can be applied via the DataNet software. 
The calibration parameters are sent to the data loggers 
wirelessly and stored in the logger’s memory.  
Users may calibrate individual input as well as all inputs at 
once. Calibration settings may be saved and then loaded into 
the logger at a later date if the calibration settings have 
changed. 
Refer to section  4.13 on page 109 for more details. 

3.6. Unit Serial Number and 
Comment 

Every DataNet data logger and Receiver/Repeater unit is 
embedded with a unique serial number.  
The data logger only can be loaded with a descriptive 
comment to identify its task and location. You may add or edit 
the comment of any logger on the network via the DataNet 
software.  
Every time data is transferred to the computer it is labeled 
both with the logger’s serial number and comment and is 
displayed in the graph or data table view. 
The unit serial number is also marked on a sticker on the back 
of the product.  
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3.7. Power Supply 

3.7.1. Receiver/Repeater 

The Receiver/Repeater unit can run from an internal NiMh 
rechargeable battery as well as from external power supply. 
However, the unit relies mainly on a fixed source of external 
power meaning the internal battery pack is generally used as 
a back up power supply in the event the external power 
supply fails.  
• When in Receiver mode, the unit must be connected to 

external power at all times. While running on internal 
power, the unit will run for only several hours before 
shutting down and therefore shutting down the DataNet 
network which the Receiver is managing. 

• When in Repeater mode, the unit must also be connected 
to external power at all times. Otherwise, when the 
internal backup batteries drains and shuts down the unit, 
all the end units dependent on the Repeater to transmit to 
the Receiver, will not be detected by the software. The 
user won’t be able to monitor data readings from these 
units until the Repeater comes back online. 

 
When connected to external power supply, the 
Receiver/Repeater battery will not be charged when the unit is 
turned off. This will allow the system to protect the battery 
from overheating. 

3.7.2. Data Logger 

The data logger can run from an internal NiMh rechargeable 
battery as well as from external power supply. From a fully 
charged battery, the data logger can run for up to four months 
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(with sampling rate of one sample every five minutes and 
transmission rate of once every ten minutes). 

Note: Battery life depends on the logger sampling rate, 
transmission rate, type of sensor, network architecture and 
number of measured sensors. 

When connected to external power supply, the data logger 
battery will not be charged when the unit is turned off. This will 
allow the system to protect the battery from overheating. 
Charge the data logger units before using them for the first 
time. 

First Time Charging 
From a fully drained battery, you must charge the battery for 
16 hours to bring it to a full charge. Once the charge cycle is 
complete, the logger will run from the external power supply, 
without draining (or charging) the internal battery. In order to 
maintain a fully charged battery and ensure the battery 
doesn’t self-discharge, the battery charger will periodically 
charge the unit for an hour to bring the battery to full charge. 

Note: Before storing the DataNet units make sure you have 
unplugged all the sensors and turned the units off.  

Standard Charging 
Whenever a logger is connected to the charger it will begin 
the 16-hour charge cycle, no matter what the status of the 
battery. Once the charging cycle is complete the logger will 
run from external power supply. 

3.7.3. Power Adapter 

The mains adaptor (AC/DC adaptor) converts mains power 
(from a wall outlet) to a voltage suitable to the DataNet 
hardware unit. 
• Output: Capacitor filtered 9 to 12 VDC, 300 mA  
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• Female plug, center negative 

Note: Only use Fourier-supplied power adapters to avoid 
damaging the units with incorrect power supply. 

3.8. USB Communication Cable 

A USB communication cable is supplied as part of the 
DataNet PC Suite. This cable connects the Receiver to the 
DataNet PC workstation. When connected to the PC the 
Receiver can communicate with the DataNet software and 
manage the DataNet network.  

Note: The USB driver is installed as part of the software 
installation process. Without this driver the PC won’t detect 
the Receiver.  

 

 

Figure 19: USB communication cable  

3.9. Data Logger/Receiver 
Keypad Overview 

The data logger and Receiver/Repeater units each have two 
buttons on the keypad, which are used to navigate through 
the menu options, as well as turn on the unit. 

 

This button has two functionalities: 
• Navigate to the main menu. When pressed 

Type A plug 
Connect to Receiver USB port 

Type B plug  
Connect to PC USB port 
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from within a submenu, the display will take 
you back to the main menu.  

• Selecting an option from one of the menus. 
When pressed on one of the main menu items, 
it will take you to the sub menu options. 

 

This button has two functionalities: 
• When the unit is off, pressing this button will 

power the unit on.  
• Scrolls through the menu options. 

3.10. Data Logger Display 
Overview 

This section explains how to use the menu options in the 
DataNet data logger unit display. 

3.10.1.  Turning on the Unit 

In order to view the logger menu options, the unit must be 

powered on by pressing the Scroll button  on the keypad. 
Ensure the logger is charged or connected to the AC adapter. 
Once the unit is switched on it will display a welcome 
message:  

 
Note: If the logger screen is inactive for thirty seconds it will 
turn off. Press the Scroll button to enable the LCD screen 
again. The screen will not turn off during firmware upgrade. 

Fourier Systems 
DataNet Logger 
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3.10.2.  Scanning for a Network 

When a logger is powered on or reset, it will automatically 
scan for a network after the welcome message has appeared.  
 
There are three scenarios that can occur while scanning for a 
network: 
• Scenario 1: The system can’t find the last network that it 

was connected to. For example, the logger is a new unit 
which was never previously joined to a network. 

• Scenario 2: The system scans and finds the last network 
it was connected to, and joins that network. 

• Scenario 3: The system can’t find any networks at all. 
 

Scenario 1 
If the unit can’t find the last network that it was connected to 
(for example, it’s a new unit), the unit will display all the 
networks that are in range: 

 
Where # is the number of networks found 
 
Once the scan has been completed the following screen 
appears: 

 

Scan complete   
 

Scan for network 
 

Scan for network  
Found # network 
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If more than one network was found, the user will need to 
select the network ID that he wants to connect to. The user 
uses the Scroll button to scroll through the Network IDs. The 
relevant network is selected using the Enter button.  

Network 1:
ID: 014.061.082  

Network 2:
ID: 021.207.175  

Network 1:
ID: 014.061.082  

Network 2:
ID: 021.207.175  

Rescan networks

 

Once the network has been selected the following screen will 
be displayed. 

 
 
To rescan the networks, simply select the Rescan Networks 
option and the logger will start the scanning process again. 
 
If only one network was found the system will automatically 
connect to that network without the user needing to select the 
network manually. 

Scan for network 
Found 1 network

Scan complete  Joined to network:
ID: 021.207.175  

Scan for network 
Found 1 network

Scan complete  Joined to network:
ID: 021.207.175  

Scan for network 
Found 1 network

Scan complete  Joined to network:
ID: 021.207.175  

 

The logger display will return to the welcome message, which 
consists of the logger name (editable via the software) and the 
network status: 
• Ready - If connection to the DataNet software is 

established. 

Joined to network: 
ID: 021.207.175   
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• Software is down - If established connection to the 
network but the DataNet software is down (PC is off, 
software is not open, etc.) 

• No Receiver – The Receiver is not connected to the PC 
resulting in a down network. 

Fourier Systems
Ready  

Fourier Systems
Software down

Fourier Systems
No Receiver  

Fourier Systems
Ready  

Fourier Systems
Software down

Fourier Systems
No Receiver  

 

Scenario 2 
When the system scans for networks and finds the last 
network that it was connected to it will automatically connect 
to the last known network. 

 

As in Scenario 1, the logger display will then return to the 
welcome message displaying the unit name and status.  
 

Scenario 3 
The system can’t find any networks at all. 
If no networks were found, the unit will display the following 
screens. 

Scan for network 
Found 0 network

Scan complete  No found networks:
Rescan networks 

 

Joined to Network: 
ID: 021.207.175   
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3.10.3.  Main Menu Options 

There are three menu categories on the data logger: 
• View Data (the default menu) 
• Status 
• Min/Max Values 

Note: If the unit is not in Run mode only the Status menu 
options will be available. 

 
Press the Menu button to reach the main menu display. Scroll 
through the main menu options (View Data, Status and 
Min/Max Values) using the Scroll button. Once you reach the 
main menu option you need, press Enter to select that option 
and enter the sub menus. 
 

View Data Menu (the default menu) 

 
 
View Data is the default page when the unit is running.  
If there is more than one sensor running, the screen will auto 
scroll between the sensors showing the sensor name and 
senor value. These are real-time displays. 
The display will switch back to the View Data screen after five 
minutes if none of logger buttons have been pressed.  
If the sensor breached any of the predefined alarm levels, 
then the alarm symbol will be displayed alongside the data 
reading.  

        
         View data   
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For example: 

 
 
The logger display alarm symbols are: 
• AL-HI : Alarm High: 
• AL-Lo : Alarm Low 
• AL-P-H : Pre Alarm High 
• AL-P-L : Pre Alarm Low 

` 

Status Menu 

 
 
The Status menu contains the following sub menus, all 
reachable by using the Scroll button.  
The sub menus are outlined below in the order in which they 
appear on the logger display. 
Name and Status 
As explained previously, the unit name is displayed on the first 
row and the second row indicates the logger status.  
If the logger is running, then the following screen is displayed. 

 

Fourier Systems 
Logger is running  

        
          Status  

In-TMP 
24˚C         AL-Lo 
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Note: Pressing the Enter button when this screen is displayed 
will make that logger’s icon in the software’s Map View blink.  

 
Battery Level   
• If the power adapter is not connected the battery 

percentage will be displayed. 
• If the power adapter is connected External power will be 

displayed.  

 

Signal Level Test   
The Signal Level test allows the user to see the signal 
strength of the path between the logger and its closest 
Receiver/Repeater unit. This test is used to determine optimal 
positioning of the logger in the facility. 

 
 
By pressing the Menu button the unit will show the signal level 
and link quality in percentage terms. 
If there is no connection the unit will display an out of range 
message 

  

Out of range Signal level:   80 
Link quality:   55 

Batt Level:      
External power 

Batt Level:     67% 

Signal level: 
Run test -> Menu 
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You will not be able to run the Signal Level test when the 
logger has lost its connection to the network. If you tried, then 
the following screens are displayed: 

 
 
Logger Version  
This menu informs the user of the logger firmware version as 
is helpful when contacting Fourier technical support, with any 
technical issues, or when upgrading the system firmware. 

 
 
S/N 
This menu displays the unit’s eight digit SN. 

 
 
Network Data 
This menu displays the network ID to which the unit is 
currently connected. This ID will match the network ID 
displayed in the software in the Receiver icon’s tool tip in Map 
View. 

 

No Parent signal Fourier Systems  
No Parent found  

Network data: 
ID: 014.061.082 

S/N 12345678 

Logger version: 
2.03.00.01.00.00 
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Leave Network  
If this option is selected, the unit will first leave the network 
and then reset itself. The scan network procedure described 
in section  3.10.2 on page 40 will begin. The only exception to 
this procedure is that even if the last connected network is 
found during the scan, the unit will not automatically connect 
to it.  

 
Reset Unit  
When the unit is reset, upon start up it will automatically scan 
for networks. The unit will automatically connect to the 
previously connected network assuming it was found in the 
network scan. 

 
 
Turn Off Unit 
Selecting this option will shut the unit down. You can turn the 
unit on again by pressing the Scroll button. 

 
 

Min/Max Values Menu  
Each sensor’s minimum/maximum readings (taken from the 
current logging session) will be displayed on two rows.  

Turn off unit 

Reset unit 

Leave network 
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The first row indicates the sensor type, along with the 
measurement units e.g. V, and the alarm indication if there is 
an active alarm on this sensor. 
The second row indicates the minimum and maximum 
measured value and the units. H and L represent High and 
Low values, respectively. 

 

3.10.4.  Additional Logger Screens 

No Parent Signal/No Parent Found 
When a logger’s parent unit, such as a Repeater or Receiver, 
goes offline then the following screen is immediately displayed 
on the logger: 

 
For example, this could happen if the Receiver managing the 
network has formed a new network, so there is no Receiver 
managing the previous network. Or if the parent unit is a 
Repeater, and it goes offline, then the logger will display this 
message.  
Once it has determined that the parent signal is lost, it will try 
to establish a connection with the network via another 
Repeater but if it fails then the following screen is displayed: 

 
 

Fourier Systems 
No Parent found 

No Parent signal 

In-TMP ˚C 
26.06H     25.61L 
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You will have to leave the network and rescan for a new 
network. 
 
Loading Firmware  
When updating the firmware of the data logger via the 
software’s Update Center, the logger screen will display the 
update progress. When complete the main logger status 
screen will be displayed. 

 

3.11. Receiver Display Overview 

This section explains how to use the menu options in the 
DataNet Receiver display. 

3.11.1.  Turning on the Unit 

In order to view the Receiver menu options, the unit must be 

powered on by pressing the Scroll button  on the 
keypad. Ensure the unit is charged or connected to the AC 
adapter. 
Once the unit is switched on it will display a welcome 
message: 

 

DataNet Receiver 
 

Loading firmware  
Progress: 55% 
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3.11.2.  Receiver Menus 

When the unit is selected to work as a Receiver (as opposed 
to working as a Repeater) the following menus are displayed 
on the unit. 
 
Unit Name 
When the unit is switched on and is in normal Receiver 
operating mode, the following screen is displayed: 

 
 
Look for Loggers 
Selecting this option will send a command to the Receiver to 
re-establish connection to the end units in its specific network. 
This is useful when wanting to ensure the network 
connectivity is performing optimally without any delay or lag 
due to changes in environmental conditions or location of the 
end units. 

 
This option is also available via the software by going to 
Network > Refresh Network Connections. 
 
Form New Network 
Selecting this option will create a new network to be managed 
by that Receiver. Any previous network will be considered 

Look for loggers 

DataNet Receiver 
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down and any end units or Repeaters connected to that 
network will now have to join a new network. 

 
This option is also available via the software by going to 
Network > Form New Network.  
 
Change Unit Type to Repeater 
Select this option to change your unit from Receiver mode to 
Repeater mode. Once you do this, any network the unit may 
have formed while in Receiver mode will be down, and you 
will need to form a new network with another Receiver unit. 

 
 
Reset Unit    
When the unit is reset, upon start up it will reconnect the 
network it previously formed and managed.  

 
 
Turn Off Unit 
Selecting this option will shut the unit down. You can turn the 
unit on again by pressing the Scroll button. 

Reset unit 

Change unit type 
to Repeater 

Form new network 
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3.11.3. Additional Receiver Screens 

Loading Firmware  
When updating the firmware of the Receiver via the software’s 
Update Center, the Receiver screen will display the update 
progress. When complete the main Receiver status screen 
will be displayed. 

 

3.12. Repeater Display Overview 

This section explains how to use the menu options in the 
DataNet Repeater display. 

3.12.1. Turning on the Unit 

In order to view the Receiver menu options, the unit must be 

powered on by pressing the Scroll button  on the 
keypad. Ensure the unit is charged or connected to the AC 
adapter. 
Once the unit is switched on it will display a welcome 
message: 

Turn off unit 

Loading firmware  
Progress: 55% 
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3.12.2.  Repeater Menus 

When the unit is selected to work as a Repeater (as opposed 
to working as a Receiver) the following menus are displayed 
on the unit. 
 
Unit Name 
When the unit is switched on and is in Repeater operating 
mode, the following screen is displayed: 

 
Look for Loggers 
Selecting this option will send a command to the Receiver to 
re-establish connection to the end units in its specific network. 
This is useful when wanting to ensure the network 
connectivity is performing optimally without any delay or lag 
due to changes in environmental conditions or location of the 
end units. 

 
This option is also available via the software by going to 
Network > Refresh Network Connections. 

DataNet Receiver 
 

Look for loggers 

DataNet Repeater 



 
 

54 

Change Unit Type to Receiver 
Select this option to change your unit from Receiver mode to 
Repeater mode. Once you do this, any network the unit may 
have formed while in Receiver mode will be down, and you 
will need to form a new network with another Receiver unit. 

 
 

Note: If the unit is in Repeater it can only be switched back to 
Receiver mode if connected to a network. If there is no 
network up and running the unit will remain in Repeater mode. 

 
Reset Unit    
When the unit is reset, upon start up it will reconnect the 
network it previously formed and managed.  

 
 
Turn Off Unit 
Selecting this option will shut the unit down. You can turn the 
unit on again by pressing the Scroll button. 

 

Turn off unit 

Reset unit 

Change unit type 
to Repeater 
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3.12.3.  Additional Repeater Screens 

Loading Firmware  
When updating the firmware of the Repeater via the 
software’s Update Center, the Repeater screen will display 
the update progress. When complete the main Repeater 
status screen will be displayed. 

 

Loading firmware  
Progress: 55% 
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Chapter 4:  
Using the DataNet 
Software  

This chapter provides detailed description of the DataNet 
software features, allowing you to manage your DataNet 
network and perform a variety of actions on your data loggers, 
such as setup, calibration, defining new sensors, managing e-
mail and SMS notifications, and so on. 

4.1. Installing DataNet 
Software 

Part of your DataNet package includes a DataNet software 
CD. Software installation instructions are provided below.  

4.1.1. System Requirements 

To work with DataNet your system should be configured with 
the following specifications: 

Software 
• Windows 2000 SP3, Windows 2003, Windows XP SP2, 

and Windows Vista 
• Internet Explorer 5.01 or higher 

Hardware 
• Pentium 800 MHz or higher  
• 256 MB RAM  
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• 250 MB available disk space for the DataNet application  

4.1.2. Installation Procedure 

1. Insert the DataNet software CD into your computer’s CD 
drive. The DataNet Installation Wizard automatically starts 
running. 

2. The Wizard first installs Microsoft .NET Framework 2.0. 
The DataNet software requires this platform in order to 
run. Follow the installation instructions to install the .NET 
Framework on your PC. This step can take up to two 
minutes to complete. Click Finish once installation is 
complete. 

3. The Silicon Laboratories USB driver installation will now 
launch. The driver is necessary for the computer to detect 
the DataNet Receiver hardware.  

4. Follow the on-screen instructions to continue the 
installation process. The default installation location is 
C:\SiLabs. 

 
Figure 20: Installing Silicon Labs USB driver – Step 1  
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5. The following window will pop up. Make sure to select the 
checkbox to launch the driver installer, and click Finish. 

 
Figure 21: Installing Silicon Labs USB driver – Step 2 

 
6. In the subsequent window, click Install to install the 

driver. 

 
Figure 22: Installing Silicon Labs USB driver – Step 3 

 
The installation of the driver could take up to one minute 
or more, depending on the system.  
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Figure 23: Installing Silicon Labs USB driver – Step 4 

 
7. Once installed click Finish to close the USB driver Install 

Wizard dialog. 
8. The main DataNet Installation Wizard now resumes. 

Follow the installation instructions to install DataNet on 
your computer. Once the installation process is completed 
click Finish.  

9. The DataNet software and components have now been 
installed. Double click the DataNet shortcut on your 

desktop  to launch the software. 
10. Connect the DataNet Receiver to a USB port on your 

computer. It will automatically detect the Receiver as new 
hardware. After a few seconds you will see a message 
stating that the device is ready for use. You may now 
begin to configure your DataNet network.  

4.1.3. Installation Troubleshooting 

When connected to the PC USB port the Receiver was not 
detected by the software. 
Ensure that the USB driver was installed properly.  
Go to Control Panel > Add/Remove Programs (in WinXP), 
and check that the driver is installed: 
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If not, you should run the Silicon Labs setup file to install the 
USB driver: CP210x_VCP_Win2K_XP_S2K3.exe setup.exe to 
install the driver.  
 
If the driver is installed, ensure that there is no other device 
sharing the USB com port with the DataNet Receiver.  
If you didn’t select the Launch CP210x VCP Driver Installer 
checkbox during step 2 of the driver installation wizard (see 
section  4.1.2), then the driver wasn’t installed. Run the wizard 
again and be sure to select the checkbox. 

4.2. DataNet Software Layout  

This section provides an overview of the default DataNet 
window view as well as a guide to all of the icons available 
throughout the software. 
The most commonly used tools and commands are displayed 
on two toolbars. Tools that relate to all aspects of the program 
are located in the main (upper) toolbar. Tools specific to the 
graphs are located on the graph (lower) toolbar.  
Refer to section  4.2.5 for a description of these toolbars 

4.2.1. Map View  

When DataNet is first launched, the default window that is 
opened is the Map View (see screenshot below). 
You can also switch to Map View at any time by clicking the 

Map View button  in the main toolbar. 
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This view is used to monitor the location and network 
connection of all of the data loggers and Repeaters in the 
network, in addition to the Receiver.  
Icons are used to represent each of the DataNet units, and 
using the mouse the user can select specific actions to be 
performed on the unit. 

 
Figure 24: Main window - Map View  
 
Refer to section  4.10 on page 89 for more details on working 
in Map View. 

4.2.2. Sensor View 

Clicking the Sensor View button  in the main toolbar 
switches the main DataNet window to a display where sensor 
data is represented in individual windows. All sensors which 
are currently online will be displayed in this view. If a logger is 
currently offline then its data will not be visible. 
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Figure 25: Main window – Sensor View 
 
There are two modes for viewing the sensor data, which may 
be toggled by going to Tools > Switch Sensor View Mode in 
the main menu.  
• Expanded view 

 
In this view, the logger comment, sensor type and sensor 
data is displayed. 

 



 
 

63 

• Slim view 

 
In this view, only the sensor type and sensor data is 
displayed. 

 
Sensor in Alarm 
When the sensor data is in alarm, the color of the sensor 
window will change according to the alarm type. There is a 
legend in the lower right corner of the main window: 

 
For example: 

 
This screenshot indicates that the Internal Digital Temperature 
reading is in High alarm, while the Internal Relative Humidity 
reading is at normal levels. 
 
Additional Features 
• The sensor windows may be dragged and placed 

anywhere on the screen. 
• Double clicking the sensor window will open the Data 

Display window, where the real-time sensor data is 
displayed in graph or table view. 
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• Scrolling over the sensor window with the mouse cursor 
will bring up a tooltip displaying the following data: 
 Logger comment 
 Battery level 
 Last sample time 
 Sensor type and reading 

 

4.2.3. History View 

Clicking the History View button  in the main toolbar will 
switch the main window to view archived, offline data stored in 
the DataNet directory on the workstation. 
You must first open the archived data file by clicking Open 

File on the main toolbar. When you open the data file it 
will be displayed in the History View, otherwise, the History 
View window will be blank.  
Refer to section  4.8: Viewing Archived (Offline) Data on page 
84 for more details on opening files in History View. 
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Figure 26: Main window – History View 
 
In History View, the user may view the data in graph or table 
format by clicking the relevant tabs, as well as view a number 
of Statistics taken from the data set.  
To learn the functionality of the lower graph toolbar, refer to 
section  4.2.5 below. 

4.2.4. Data Map 

The History View window also includes the Data Map pane, 
on the left of the window. 
The Data Map displays all data sets opened in History View, 
saved in the current project file, and includes nodes for each 
sensor in the data set.  
Clicking the sensor label removes the data from the graph. 
When the label is black, the data is not displayed on the 
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graph. The sensor data plot color is matched to the color of 
the sensor label in the Data Map.  

Each data set is preceded by a Logger icon , which can be 
expanded or collapsed to display the associated sensor data. 

Clicking the Data Map button  in the lower graph toolbar 
removes the Data Map pane altogether allowing a full screen 
graph view. 

 
Figure 27: Data Map 

4.2.5. DataNet Toolbar Icons 

This section outlines all of the toolbar icons available in the 
software. 
 

Main (Upper) Toolbar Icons 

 
Figure 28: Main toolbar icons 
 
The main toolbar is always available at the top of the DataNet 
application, no matter what window view the user is in.  

Data Map 
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This toolbar cannot be moved or hidden. 

•  Open file - Opens archived logger data file 
stored on the PC 

•  Map view - Switches main window to Map 
view, where the units connected to the DataNet 
network are represented 

•  Sensor view - Switches main window to 
Sensor view, where data from each running 
sensor is displayed in a simple view 

•  History view - Switches main window to 
History view, where archived logger data can 
be viewed and analyzed 

•  

 

Alarm mute/unmute - Mutes or unmutes an 
audible alarm in the system when a sensor 
reading has breached the user-defined alarm 
level 

•  Alarm Notification Setup - Configuration 
window for e-mail and SMS alarm notifications 

•  GSM Modem - Indicates if GSM modem is 
connected or disconnected 

•  Temperature unit toggle - Display all data in 
Celsius  

•  Temperature unit toggle - Display all data in 
Fahrenheit 

Table 2: Main toolbar icon list 
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Map View Icons 
The following icons representing the various statuses of the 
DataNet units are viewed in Map View. Using these icons the 
user is aware of the online/offline status of each unit, as well 
as the battery level and signal level of the loggers and 
Repeaters.  
Alarm status is also indicated: Green = Normal ; Red = Alarm 
 

• 
 

Receiver is online and connected to the PC. 

• 
 

Receiver is offline, possibly as USB cable has 
been disconnected or it was removed from 
external power supply (and backup battery 
drained). 

• 
 

Logger newly acquired by network and 
awaiting Setup.  
Running from internal battery supply. 

• 
 

Logger newly acquired by network and 
awaiting Setup.  
Running from external power supply. 

• 
 

Logger which has received its Setup but is in 
Stop mode. 
Running from internal battery supply. 

• 
 

Logger which has received its Setup but is in 
Stop mode. 
Running from external power supply. 

• 
 

Logger in Run mode and running on battery 
supply. 
Green indicates there are no alarms. 
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• 
 

Logger in Run mode and running on external 
power supply. 
Green indicates there are no alarms. 

• 
 

Logger in Run mode with an alarm alert. 
Running from internal battery supply.  

• 
 

Logger in Run mode with an alarm alert.  
Running from external power supply. 

• 
 

Logger no longer detected on the network and 
is offline. Its power supply may have failed or 
it’s out of range of the Receiver. 

• 
 

Logger is processing a command sent from the 
software. 

• 
 

Logger is downloading data. 

• 
 

Repeater is online and is running from external 
power supply. 

• 
 

Repeater no longer detected on the network 
and is offline. Its power supply may have failed 
or it’s out of range of the Receiver. 

Table 3: Main toolbar icon list 
 

Graph (Lower) Toolbar Icons 
The graph toolbar is located at the bottom of the open graph 
view, when the user is either in Online Data Display: 
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Or History View: 

 
The toolbar cannot be moved or hidden. 

•  
Data Map (in History View only) – Hides or 
shows the Data Map pane in the History View 
window. 

•  
Plot Legend (in Display Data View only) – 
Hides or shows the sensor label from the 
bottom of the graph. 

•  
Autoscale - Returns the data to its default 
scale. 

•  
Zoom in – Zooms in on the graph data. 

•  
Pan graph – Pans the graph along the x or y 
axis. 

•  
Select first cursor – Adds a cursor to the 
designated plot on the graph 

•  
Select second cursor – Adds a second cursor 
to the designated plot on the graph. 

•  
Copy graph – Copies the graph to your 
clipboard, to be copied to a document or 
spreadsheet, for example. 

•  
Graph properties – Opens the Graph 
Properties window.  

•  
Export to Excel – Export the open data sets to 
Excel format. 

•  
Print – Opens the Print dialog. Available for 
graph, table and statistics views. 

Table 4: Lower graph toolbar icon list 
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Data Map Icons 

• 
 

Displayed internal Temperature sensor data 
set 

• 
 

Hidden internal Temperature sensor data set 

• 
 

Displayed internal Humidity sensor data set 

• 
 

Hidden internal Humidity sensor data set 

• 
 

Displayed external sensor data set 

•  
Hidden internal sensor data set 

• 
 

Displayed graph function 

• 
 

Hidden graph function 

• 
 

Parent node for all data sets. Click to expand 
or collapse all child nodes. 

Table 5: Data Map icons 
 

4.3. File Menu Items 

4.3.1. Open 

Select Open to access archived data files for each logger in 
your network. 

Shortcuts: You can also click the Open icon  or press 
Ctrl+O to open archived files. 
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4.3.2. Open Project File 

Opens project files of offline data, containing data from one or 
more loggers, as opposed to standard data files containing 
data from only one logger. 

4.3.3. Save Project 

Only enabled while in History View, this feature allows you to 
save more than one data set into one Project File. 

4.3.4. Save Project As 

Use this feature to save an existing Project file under a 
different name. 

4.3.5. Exit 

Exits the DataNet application.   

4.4. Network Menu Items 

All of the Network menu items are also accessible via the 
Receiver context menu, by right-clicking the Receiver icon in 
Map View: 
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4.4.1. Detect Receiver 

When the Receiver is connected to the USB port it is 
automatically detected by the software. If you connect the 
Receiver while it is switched off, and then switch the Receiver 
on, the software won’t detect the unit. You will have to use the 
Detect Receiver feature. 
The Receiver may also lose power and go offline while 
connected to the USB, in which case you will also need to 
detect it manually. 
If no Receiver is detected by the software an error message 
will pop up stating that the Receiver was not detected. 

4.4.2. Lock Network 

By locking the network you do not allow any new end units to 
join the network. During the network scan, the logger will not 
even detect the network if it is locked. 
By unlocking the network you leave it open for any end unit to 
join the network, even if you do not wish them to. 

4.4.3. Form New Network 

Select this option to form a new network using the current 
Receiver or another Receiver if you are building more than 
one network. 
If you form a new network, any loggers connected to the 
previous network created by the Receiver will need to rejoin 
the network. This must be done manually by going to each 
logger and resetting it via the display menu options. 
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4.4.4. Refresh Network Connections 

Use this feature to send a command to the Receiver to re-
establish connection to the end units in its specific network. 
This is useful when wanting to ensure the network 
connectivity is performing optimally without any delay or lag 
due to changes in environmental conditions or location of the 
end units. 

Note: The software automatically refreshes the network 
connections every 30 seconds. 

4.4.5. Show Network Paths 

While in Map View, enable this option to display the path that 
the RF signal of all loggers in the network takes to reach the 
Receiver. If Repeaters are used in the network it will show the 
signal routed via the Repeater, en route to the Receiver.  

 
The paths are color-coded so you can also see the 
transmission strength. A legend appears at the bottom of the 
window.  
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• Red = Low (0 to 33% strength) 
• Yellow = Medium (33.4 to 66.6%) 
• Green = High (66.7 to 100%) 
 
You can also enable this feature for specific loggers by 
opening the context menu on the Logger icon in Map View 
and selecting Show Network Paths. 

4.5. Tools Menu Items 

4.5.1. Define Sensor 

DataNet enables the user to define custom sensors. This is a 
useful tool for when the data logger is communicating with 
many sensor types from different vendors.  
Any additional sensor that you would like to connect to the 
logger must comply with the following restrictions: 
The sensor’s output must be either voltage in the range of 0 to 
1 V, 0 to 50 mV or current in the range of 4 to 20 mA. 
1. Click Tools > Define New Sensor and the Define New 

Sensor dialog will open.  
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Figure 29: Define New Sensor dialog 

 

2. Click Add to enable the fields. 
3. Select the Base sensor from the drop-down menu 

(depending on whether your sensor’s output is 0 to 1 
V, 0 to 50 mV, 4 to 20mA, or measuring pulses). 

4. Enter the sensor name and sensor unit. 
5. Enter two calibration values (two real values and the 

corresponding output values of the sensor). 
6. Click Close. 
 
To use the custom defined sensor: 
1. Enter the Setup dialog for the data logger you want to 

configure.  
2. Select the Input you wish to use and from the Sensor 

Type drop-down menu, select the custom sensor, which 
now appears in this list.  
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3. Proceed with the setup as you would normally do. 

4.5.2. Switch Sensor View Mode 

While in Sensor View, selecting this option will switch the 
sensor view between large and small window sizes. By 
reducing the size of the sensor window you display only the 
sensor type and sensor data. Enlarging the size of the sensor 
window will display sensor type, sensor data and logger 
name. 

4.5.3. Lock Map View 

While in Map View, with Lock Map View selected the Map 
View icons are in a fixed position and can’t be moved. You 
must unselect this option in order to freely move the icons 
anywhere on the screen. This is essential if working with a 
custom background image.  

4.5.4. Options Menu Items 

The Options dialog is divided into three tabs:  
• Preferences 
• e-mail Settings 
• SMS Settings 
 



 
 

78 

Preferences Tab 

 
Figure 30: Options > Preferences tab 
 
The Preferences tab includes the following options: 
 
Minimize DataNet to system tray 

When this checkbox is selected, the DataNet icon  will 
appear in the computer’s system tray in the lower right of the 
screen when the application is minimized. Simply double-click 
the icon to maximize the application to full screen. 
 
Map View background 
Use this option to toggle between Stretch and Center views 
for the background image used in Map View. 
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Set decimal places for… 
For each DataNet sensor, internal or external, you may select 
between 0 and 6 decimal places to be used when displaying 
the data in the software. 
 
Date format 
Choose between four date formats to be used throughout the 
software when displaying data e.g. in the Graph display. 
 
Ignore regional settings when exporting to CSV 
Selecting this option will ensure that data will be corrected 
exported to a CSV file and will not use any custom regional 
settings in the Windows OS which might adversely affect the 
layout of the data in the CSV file. 
 
Path for DataNet data files 
The default path for saving all data recorded by the data 
loggers is:  
C:\Program Files\Fourier Systems\DataNet\DataNet data files\ 
Click Browse to change the path e.g. to a network path. 
Save text data files 
Select this checkbox if you would like DataNet to also save 
the logger data to a text file. The default path is: C:\Program 
Files\Fourier Systems\DataNet\DataNet data text files\ and 
clicking Browse will let you change this path. 
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Enable automatic data download when DataNet is 
launched 
Select this checkbox if you want to have automatic download 
of data when the DataNet software is launched. If there are 
many loggers in the system with fast sampling rates, then the 
download could burden the network. Therefore in some cases 
disabled this feature is advised. 
 

e-Mail Settings Tab 
DataNet’s alarm notification feature enables sending of e-
mails to notify the user of any alarm in the system. First select 
the Send e-mail notifications check box. Fill in the fields 
accordingly so that DataNet will be able to send e-mails to 
predefined e-mail contacts when your loggers have breached 
certain alarm levels. 
Refer to section 4.11.2 on page 100 for setting Alarm levels 
and section  4.12 on page 103 for creating e-mail contacts.  

Note: DataNet supports SMTP and MIME encoding, and 
POP3 mail protocols.  

 
Figure 31: Options > e-Mail Settings tab 
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SMS Settings Tab 
DataNet’s alarm notification feature enables sending of SMS’s 
to notify the user of any alarm in the system. First select the 
Send SMS notifications check box. Using the SMS feature 
requires connection of a GSM modem and SIM card to the 
DataNet PC, or even just a mobile phone with an active SIM 
card.  
You must select the COM port which the GSM modem/mobile 
phone is connected to in order for the software to detect it. 
Once the configuration is complete, DataNet will be able to 
send SMS’s to predefined SMS contacts when your loggers 
have breached certain alarm levels. 
Refer to section 4.11.2 on page 100 for setting Alarm levels 
and section  4.12 on page 103 for creating SMS contacts.  

 
Figure 32: Options > SMS Settings tab 
 

Note: Once the GSM modem is online you will see the GSM 
icon appear green in the DataNet upper toolbar. 
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Update Center 
The Update Center is where the DataNet firmware updates 
are handled. Please refer to section  4.17 on page 125 
regarding this item in the Options menu. 

4.5.5. Analysis Menu Items 

The Analysis menu items become enabled when viewing 
offline data in History View. 
The Analysis options available are: 
• Functions Parameters 
• Dew Point 
• FO Pasteurization 
• Histogram 
• Export to Excel 
• Export to CSV 

 

Export to Excel 
You may export offline data to Excel by selecting this menu 

item or by clicking the Export to Excel icon  in the lower 
graph toolbar in History View. The data is opened in an Excel 
worksheet and includes pertinent information such as logger 
name, SN, sensor names, alarm levels as well as the actual 
data readings. 
Refer to section  4.15 for more information. 
 

Export to CSV 
You may export offline data to CSV file format by selecting 
this menu item. Upon selecting this option, you will be 
prompted to save the file either in the default DataNet 



 
 

83 

directory or in directory of your choosing. The data is opened 
in CSV file format and includes pertinent information such as 
logger name, SN, sensor names, alarm levels as well as the 
actual data readings. 
Refer to section  4.15 for more information. 

4.6. Data Recovery 

The ability to recover data when part of the system goes 
offline or is shutdown is a key feature of the DataNet system.  
When the data loggers are acquiring data they transmit to the 
Receiver at the predefined rate, either directly or via one or 
more Repeaters.  
There may be occasions when the data transmission fails and 
the data is not updated in real-time in the software window. 
When this happens, the software has several ways of 
recovering the data so the user will always be able to view all 
samples recorded by the logger. The online system will never 
lose data i.e. the data integrity will always been maintained.  
If the end unit tries to send data to the Receiver but fails, it will 
continually try to send the data until it succeeds. In such a 
case, the software or workstation may be shutdown or its 
parent unit, the Repeater, may be offline. Or the end unit itself 
may go offline due to a drained battery. Once the end unit has 
reconnected with the network, for instance when the software 
is reopened or the Repeater is back online, it will be able to 
complete the transmission of all its data and the software will 
be updated with this data. The data recovery is all completed 
automatically and the user is not required to perform any 
specific actions. 
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4.7. Saving Data 

As soon as a logger starts to record data the software creates 
a data file to which it writes the logger data. 
Logger data files are stored in the following default location: 
C:\Program Files\Fourier Systems\DataNet\DataNet data files 
 
A folder is created for each data logger and is named 
according to the logger Serial Number. In this folder is stored 
the data files. A file is created for each day that the logger is 
recording data. The file name format is the date followed by 
the file extension e.g. 2007-12-30.dat.  
 
The data is saved automatically by the software. There is no 
need for the user to save the data manually. The data is 
saved to the data file as follows: 
• Every 15 minutes 
• When the software is closed 
• When the user opens an archived data file, the file is 

updated with all data not saved to that point 
 
You can also save the data in a text file format. Refer to the 
Preferences heading under section  4.5.4 for more details. 

4.8. Viewing Archived (Offline) 
Data  

The user can view the logger data online or can choose to 
open archived data. Archived data is all data that was logged 
by a specific logger and recorded by the software into the 
DataNet directory on the PC.  
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Follow the instructions below to open archived data. 
1. Click the Open icon to launch the Open Data Files 

dialog. 
2. Select the logger from the list of loggers in the dialog.  
3. Using the calendar define the date and time period for 

which you wish to view your data and click OK. 

 
Figure 33: Open Data File dialog 

 
4. In the Sync Data dialog, you can select the sampling rate 

at which you wish to display the data. The default option 
is the original rate. Click OK. 
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Figure 34: Sync Data dialog 

 
The data is opened in History View. Refer to section  4.2.1 for 
an explanation of the History View.  
You may display data sets from more than one logger and 
display them all in History View, using the Data Map to 
navigate through the data. Refer to section  4.2.4 for more 
details regarding the Data Map. 

4.9. Viewing Online Data 

You can view the data from any of your network loggers in 
real-time, as the data is being recorded and transmitted to the 
PC: 

• Double click the Logger icon  in the Map View. 
• Open the logger context menu and select Display Data. 
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Figure 35: Online data window 
The data displayed in this window is the data that was 
transmitted by the logger in the current software session. Data 
transmitted during a previous session of the software being 
open will not be displayed. This data can be viewed by 
opening archived data. Refer to section  4.8. 
You may view the data in a graph or table by clicking the 
relevant tabs in the online data window. While in either or 
these views, the data is constantly being updated in real-time 
in the respective view according to the transmission rate of 
the logger. 

4.9.1. Showing/Hiding the Data Sets 

In the online graph display, where you have data from only 
one logger displayed, you can show or hide the individual 
sensor data by using the sensor labels at the bottom of the 
graph. 



 
 

88 

 
 
In the screenshot above you can see two labels, Internal 
Digital Temperature and Int RH. At present, each label is 
active meaning the sensor data corresponding to the label is 
shown on the graph. 
By double-clicking any of the sensor labels, you can hide the 
data from the graph. The label will then be grayed out. See 
the screenshot below: 

 
 

Note: You can hide all of the sensor labels from the graph by 

clicking the Plot Legend icon . 
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4.10. Working in Map View 

The Map View is the main view from which you monitor your 
online network. It is in this view that you can see all the icons 
representing the units in your system, the Receiver, loggers 
and Repeaters too, if relevant.  
Refer to section  4.2.1 on page 60 for a quick overview of the 
Map View and section  4.2.5 on page 66 for a list of all the 
Map View icons. 

4.10.1.  Loading Map View Wallpaper 

You can load an image file representing a map of your facility 
in which the network is operating. You can then move the unit 
icons into their actual positions on the map. 
• Double-click on the Map View background to go straight 

into the Open dialog and locate the image file. 
• Right-click on the Map View background to open the 

Wallpaper dialog and have the option to either Load or 
Reset the wallpaper. 

Note: When deploying the system for the first time it is highly 
recommended to use a map of the facility to make the 
deployment work efficiently. 

4.10.2.  Moving Icons around the 
Screen 

Go to Tools > Lock Map View and ensure this menu item is 
not selected in order to freely move the unit icons around the 
screen. When you have finished placing the icons into 
position you may then lock the Map View so as not to 
mistakenly place an icon out of position. 
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4.10.3.  Logger Icon Context Menu 

Right clicking the Logger icon will give the following options: 

Display Data 
Displays the logger’s data in Graph view. The graph displays 
the data in real-time. There is also the option to display the 
data in Table view or to view the data statistics. 
 

Download Data 
Downloads all data in the logger memory to the DataNet 
software. When logger is downloading the data, the Logger 
icon in Map View will appear as follows: 

 
 

Cancel Download 
When logger is downloading data you may cancel the 
download per logger by selecting this menu item. 
 

Reset Alarm 
When the logger is in a state of alarm, this option will reset the 
alarm state to normal on both the logger and the software. 
The visual and audible alarms will return to normal. If after 
reset the logger is still in alarm conditions, then the visible and 
audible alarms will return. 
 

Call Logger (Beep) 
This feature sends a command to the logger to beep for a 
couple of seconds. This is useful when trying to physically 
locate a logger in your facility. 
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Calibration 
Refer to section  4.13 on page 109 for an overview of the 
Calibration feature. 

Note: A logger can’t be calibrated while it is in Run mode. 
The option will be grayed out. You must Stop the logger first. 

 

Update Firmware 
Refer to section  4.17 on page 125 for an overview of the 
Update Firmware feature. 
  

Leave Network 
Selecting this feature will kick the logger off the network. The 
logger will reset and will start scanning for a new network to 
join.  
You will be prompted to enter a password when selecting this 
feature.  

Note: The default password is 1234. 

 

Setup  
Refer to section  4.11 on page 97 for an overview of how to 
setup the logger. 
 

Multi-Setup  
By using multi-setup you can select more than one logger on 
the Map View and send the same configuration to all of the 
loggers. When this option is selected, a dialog will open listing 
all of the loggers in the multi-setup selection. 
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Stop 
Sends a command to the logger to stop logging data. 
 

Run 
Sends a command to the logger to start logging data. This 
command will also clear the existing logger memory. 
 

Show Network Path 
Displays the path of the logger RF data transmission to the 
Receiver. The Transmission Strength legend appears in the 
bottom right of the screen when this feature is enabled. Refer 
to section  4.4.5 for more details. 
 

Remove 
This option removes from the Map View any icons of loggers 
that are not on the network anymore and so are irrelevant.  

4.10.4.  Viewing Logger Status  

When you scroll the mouse cursor over the Logger icon a 
tooltip will pop up displaying data relevant to the Logger status 
at the time. 
 

Logger Tooltip 
The tooltip will always display the following data, even if 
offline: 
• Serial Number 
• Logger Name/Comment 
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When the logger is online and running the following tooltip is 
displayed: 

 
In online mode, the logger also displays:  
• The Power status (% Battery left or Connected to AC) 
• Reception Quality: Strength of RF signal between logger 

and Receiver 
• Version: Version of logger 
• Last Sample Time: If logger is running, time stamp of last 

recorded sample.  
• Real-time Sensor values: All sensor values are displayed, 

including sensor name. 
 

Command Queue Progress 
The tooltip is updated with specific commands being 
performed by the logger. For example, if the logger is 
downloading data to the software you can see the progress in 
the tooltip. In addition, the Logger icon has a blue progress 
indicator so you can monitor the progress without using the 
tooltip.  
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Common commands include Download, Setup, Stop, Run and 
more. 

4.10.5.  Receiver Icon Context Menu 

Right clicking the Receiver icon will give the following options: 
• Update Firmware 
• Lock Network 
• Form New Network 
• Refresh Network Connections 
• Show Network Path 
Refer to section  4.4 on page 72 for more details regarding 
these features. 

4.10.6.  Viewing Receiver Status  

When you scroll the mouse cursor over the Receiver icon a 
tooltip will pop up displaying data relevant to the Receiver 
status at the time. 
 

Receiver Tooltip 
The tooltip will always display the following data, even if 
offline: 
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• Unit type (Receiver)  
 
When the Receiver is online the following tooltip is displayed: 

 
In online mode, the Receiver also displays:  
• Serial Number 
• Network: The Network ID of the currently formed network 
• Version: Version of Receiver 

4.10.7.  Repeater Icon Context Menu 

Right clicking the Repeater icon will give the following options: 
 

Setup  
Repeater Setup lets the user change the name of the unit. 
Once the name has been changed, click Setup (or Close to 
close the dialog without making any changes). 
 

Multi-Setup  
By using multi-setup you can select more than one Repeater 
on the Map View and send the same configuration to all of the 
Repeaters. 
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Call Repeater (Beep) 
This feature sends a command to the Repeater to beep for a 
couple of seconds. This is useful when trying to physically 
locate a Repeater in your facility. 
 

Leave Network 
Selecting this feature will kick the Repeater off the network.  
You will be prompted to enter a password when selecting this 
feature.  

Note: The default password is 1234.  

 

Update Firmware 
Refer to section  4.17 on page 125 for an overview of the 
Update Firmware feature. 
 

Show Network Path 
Displays the path of the Repeater RF data transmission to the 
Receiver. The Transmission Strength legend appears in the 
bottom right of the screen when this feature is enabled. Refer 
to section  4.4.5 for more details. 

Remove 
This option removes from the Map View any icons of 
Repeaters that are not on the network anymore and so are 
irrelevant.  

4.10.8. Viewing Repeater Status  

When you scroll the mouse cursor over the Repeater icon a 
tooltip will pop up displaying data relevant to the Repeater 
status at the time. 
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Repeater Tooltip 
The tooltip will always display the following data, even if 
offline: 
• Unit type (Router)  
• Serial Number 
• Repeater Name/Comment 
 
When the Repeater is online the following tooltip is displayed: 

 
In online mode, the Repeater also displays:  
• The Battery status (% battery left or Connected to AC) 
• Reception Quality: Strength of RF signal between logger 

and Receiver 
• Version: Version of Repeater 

4.11. Configuring the Logger 

DataNet software allows you to configure each logger in your 
network wirelessly. You do not need to have the loggers near 
your workstation, other than for the initial setup when you 
need to connect the sensors (if you’re using external sensors).  
You can also refer to section 2.6 on configuring the logger in 
the Quick Start Guide. 
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To configure the logger once it’s online on the network, right-
click the Logger icon in the Map View and select Setup. 
You have two tabs, Device Setup tab and Alarm Setup. 
The main logger configuration is performed on the Device 
Setup tab. Any alarm levels you wish to configure is 
performed on the Alarm Setup tab. 

4.11.1.  Device Setup Tab 

Comment 
This is the name of the logger. It is advisable to name the 
logger according to the location in the facility. 

 

Sampling Rate 
Sampling rate is one sample per second to one sample per 2 
hours. However, there are programming limitations you must 
be aware of when configuring the loggers. The sampling rate 
will vary depending on the number and type of sensors you 
setup. Refer to section  3.5.5 on page 32. 
 

Transmission Interval 
You can define how often the logger will actually transmit to 
the network. You may wish to have the logger transmit with 
every sample, if you have slower sampling rates, or less 
frequently, if you have a fast sampling rate. 
The transmission interval must be a multiple of the sampling 
rate, so for example if the sampling rate is 3 seconds, then the 
minimum transmission rate must be every 3 seconds, and 
then every 6 seconds, 9 seconds, and so on. 
This parameter was designed to ease the burden on the 
network if you have many loggers as each logger can transmit 
at different rates. 
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Averaging Points 
You can choose have online averaging of up to 10 points 
around the real value in order to smooth the data readings, if 
they are a little noisy. 
 

Temperature Units  
Toggle between °C and °F. This applies to the readings 
displayed on the logger LCD as well as in the software.   
 

Active Sensors  
Depending on the logger model, you can activate up to two 
internal sensors and four external sensors. Simply select the 
inputs you want to use and then select the sensor types from 
the adjacent drop-down menu. You don’t have to select the 
external sensor input in any order. You may select only Input 
4 if you desire. 

Note: You cannot run the humidity sensor without running the 
temperature sensor in parallel. 
This is because when using the DNL920 data logger and 
selecting the internal humidity sensor in the Device Setup 
dialog, the internal digital temperature sensor will 
automatically be selected as well. This sensor provides the 
temperature compensation necessary for the humidity sensor 
to reach the 3% accuracy as stated in the sensor 
specifications. It is not used for recording temperature. The 
internal digital sensor is used to record temperature on the 
DNL920. 

 

Custom Sensor Names  
You can also give the sensor a custom name, which will 
appear in the software when viewing the data. This is 
convenient when using several of the same type of sensors 
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and you wish to differentiate between them in terms of their 
environment or material it is measuring. 
 

Recording Time 
This field displays the length of time the logger memory will be 
able to record for depending upon the number of sensors 
used and sampling rate. 
 

Setup and Run 
Clicking Setup and Run will send the setup to the logger and 
immediately start logging data. 
 

Setup Only 
Clicking Setup Only will send the setup to the logger but it will 
not actually start logging data. You will need to select Run 
from the Logger context menu or go back into the Setup 
dialog.  
 

Close  
Clicking Close will close the Setup dialog without saving any 
of your configurations. 

Note: Running the logger clears the logger memory. All 
previously recorded data will be erased when you begin a new 
logging session. 

4.11.2.  Alarm Setup Tab 

A major feature of the DataNet system is the ability to 
configure alarm levels into the loggers so any breach of these 
levels as recorded on the data logger is monitored by the 
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software, and the user is notified via e-mail/SMS/audible and 
visual indicators. 
 
The Alarm Setup tab lets you configure each sensor for the 
following alarms: 
• Low 
• Pre-Low 
• Pre-High 
• High 

 
Using the Pre Alarms gives the user ample warning of a 
possible breach of real alarm levels, so necessary measures 
can be taken to prevent such a breach.  
Simply select the check box for the type of alarm you wish to 
be notified. You can select all alarms too. Enter the alarm 
value in the text box. 
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Figure 36: Alarm Setup tab 
 

Alarm Delay and Pre-alarm Delay 
The time until the alarm (or pre-alarm) is activated. You may 
not want to have the alarm sound immediately after the alarm 
level is breached as you are only interested in a condition 
where the alarm level lasted a certain amount of time. 
For example, if monitoring change of temperature in a freezer, 
you would only be interested in a High alarm which lasted 
more than one minute as anything else could just be caused 
by the freezer door opening for a few seconds, as opposed to 
a power failure leading to rise in temperature.  
 

Alarm Duration 
The duration of the alarm that is set off by one or more 
sensors breaching the alarm level. 
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Sound Alarm during Pre-alarm 
You also have the option to sound the alarm in the software 
during a pre-alarm scenario, not just for a standard alarm. 
 
Once you have configured your alarms, you may return to the 
Device Setup tab or click one of the Setup buttons at the 
bottom of the tab. 

4.12. Alarm Notifications Setup 

Once you have completed the logger alarm setup in section 
 4.11.2 above, you can now move to the Alarm Notification 
dialog to indicate which e-mail or SMS alarm notifications 
need to be sent by the DataNet software. 

Note: You must define the e-mail and SMS settings in the 
Tools > Options dialog, and connect a GSM modem if 
sending SMS’s. Refer to section  4.5.4 on page 77 for more 
details. 

In this dialog you also create your contact list of people who 
should receive the notifications.  

Click the Alarm Notifications Setup button  in the upper 
toolbar to open the Alarm Notifications Setup dialog. 
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Figure 37: Alarm Notifications Setup dialog 

 
This dialog is divided into the following tabs: 
• Notifications Setup tab 

 SMS tab 
 e-mail tab 

• Contacts tab 
• Groups tab 

4.12.1.  Contacts Tab 

The first step is to create the contacts who shall be receiving 
the notifications. 
1. Click the Contacts tab and then click Add Contact. 
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Figure 38: Adding a contact 

 
2. In this dialog you must first enter the contact name in the 

Name field. That is the only mandatory field but if you 
don’t enter at least the phone number or e-mail then they 
won’t receive any alarm notifications. 
The other fields in the dialog are as follows: 

 Title: Corporate position 
 Phone number: The number the DataNet software 

will use to send the SMS notification. 
 e-mail: The address the DataNet software will use to 

send the e-mail notification. 
 Workday Start and End: You can define the hours in 

which the contact will be eligible to receive the 
notifications i.e. so they don’t receive SMS or e-mail 
while in the office, or vice versa. 
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 Vacation: You can define when the contact is on 
vacation so they won’t receive any notifications over 
this period. 

 Number of SMS resends: The number of times 
DataNet will send follow-up SMS’s with the alarm 
notification. 

3. When the contact details have been entered, click OK. 
4. The contact will be added to the Contacts tab. You may 

choose to add another contact, edit an existing contact or 
remove a contact from the list. 

4.12.2.  Groups Tab 

1. Click the Groups tab and then click Add Group. The 
Group Details dialog will open.  

 
Figure 39: Adding a group 
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2. Enter a Group name and add your existing contacts to the 
group by selecting the checkbox next to the Contact 
name. 

3. Click OK to create the Group. In the Groups tab you may 
choose to add a group, edit an existing group or remove a 
group from the list. 

4.12.3.  Notifications Setup Tab 

1. Once the contacts have been created you may start 
defining which contacts should receive the alarm 
notifications. 

2. The pane on the left hand side of the Notifications Setup 
tab displays all the loggers which have been configured in 
your network. You must define the alarm notifications for 
each logger in turn. Select the first logger you wish to 
define.  

3. The SMS and e-mail tabs are now active for the logger 
you selected in step 1 above. These two tabs are identical 
except one notifies the contacts via SMS and the other via 
e-mail. 

4. Select a tab, SMS or e-mail, and select the type of alarms 
for which you want to be notified, should the predefined 
alarm level be breached.  

5. Only the sensors configured, with alarms, in the logger 
Setup will be enabled here. 



 
 

108 

 
Figure 40: SMS and e-mail notification setup 

 
6. Select the checkboxes according to the type of sensor 

alarm you wish to be notified. 
You may also select the following alarms: 
a. Battery alarm: Notification will be sent for low battery 

alarm when battery level drops below 10%. 
b. Reception alarm: Notification will be sent when there 

is no RF reception from a unit.  
c. Normalized: Notification will be sent when the logger 

return to normal levels having been in alarm. 
7. Click the Contact button adjacent to each of the sensors 

which have defined alarms. In the Select Contact dialog, 
select the contact and/or group that will receive the 
notification. 

8. You can also click Check All to select all the sensor 
alarms for notification. 
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4.13. Calibration 

The DataNet data loggers are shipped fully calibrated. 
However, DataNet does provide a simple and efficient 
process for calibrating the DataNet data loggers. The process 
itself can be performed wirelessly, over the network, but as 
with any data logger calibration a calibrator or other type of 
calibration instrument is necessary. 
 
The Calibration options are accessible via the Logger context 
menu in Map View (right-clicking the Logger icon).  
Before performing logger calibration, the logger must be in 
Stop mode. In addition, all of the calibration options are 
accessible with a password making it difficult for non-
authorized users of the system to tamper with the loggers’ 
calibration settings. 

Note: The default password is 1234. 

 
The Calibration option menu options are: 
• Calibration: Opens the main Calibration dialog 
• Save Calibration: Saves the logger’s current calibration 

settings 
• Load Calibration: Loads a logger’s previously saved 

calibration settings 
• Reset Calibration: Resets the logger’s calibration 

settings so that the raw hardware data is obtained, 
without any software calibration applied to these values. 

• Restore Factory Calibration Default: Restores the 
logger’s calibration settings to the factory calibration i.e. 
the calibration settings it received prior to shipment from 
Fourier. 
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4.13.1. Introduction to DataNet 
Calibration  

Although the DataNet data loggers come fully calibrated, the 
software enables you to calibrate any of the DataNet sensors, 
on any input. The calibration parameters are sent to the data 
logger and stored in its memory.  

DataNet employs two different calibration methods: Two-
point calibration and Offset calibration. 

Each sensor can be calibrated using Two-point calibration 
method, and then tweaked using offset calibration, except for 
the Thermocouples. These sensors require offset calibration 
only. 

Sensor Type Calibration 
Method 

Current 4 – 20 mA Two-point 
calibration 

Humidity (Internal) Digital Two-point 
calibration 

Temperature 
(Internal) Digital Two-point 

calibration 

Temperature 
(Internal)  PT-100 

Two-point 
calibration and 
offset 

Temperature PT-100 2-wire 
Two-point 
calibration and 
offset 

Temperature Thermocouple J Offset calibration 
Temperature Thermocouple K Offset calibration 
Temperature Thermocouple T Offset calibration 
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Voltage 0 to 1 V Two-point 
calibration 

Voltage 0 to 50 mV Two-point 
calibration 

 

Calibration Tips 
• Prior to any two-point calibration it is recommended to 

restore factory calibration defaults. 
• Prior to calibrating any of the thermocouple sensor types, 

calibrate the Voltage 50 mV sensor as this will set the 
gain (slope) of all thermocouple sensor types. 

• After calibrating 50mV, TC-J, TC-K or TC-T sensor types 
for all inputs you can refine the offset calibration for each 
input individually. 

 

Two-point Calibration 
The two-point calibration sets the gain (slope) and offset 
(intercept) of the sensor's conversion function. 
Use the two-point calibration to calibrate all DataNet sensors 
except for the Thermocouples. In some cases you may need 
to refine your calibration using the fine offset tuning tool. 
 

Offset Calibration 
To calibrate the Thermocouple temperature sensors: TC-J, 
TC-K and TC-T, first calibrate the 50mV sensor type. That will 
set the slope for all Thermocouple temperature sensors. Then 
proceed to adjust the offset using the Offset calibration 
technique. 
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4.13.2.  Calibrating the Data Logger 

 
Figure 41: Calibration dialog 
1. From the Map View, open the Logger context menu and 

select Stop. 
2. Select Calibration > Calibrate and enter the password in 

the Password dialog. 
3. Select the sensor you wish to calibrate from the Sensor 

drop-down menu.  
4. If calibrating an external sensor, select the inputs to 

calibrate. Select All or an individual input, 1 to 4. 
5. Click Setup to send the sensor setup to the logger.   

Note: The calibration process does not delete the logger’s 
setup prior to calibration. Once Calibration is complete the 
original logger setup will be restored. 

6. If you selected All inputs, then by default the logger will 
be setup to log data on Input 1 during the calibration 
process. Otherwise, if you selected a specific input, it will 
setup the logger to calibrate on that input.  
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For example: 

  
Calibrating on All inputs Calibrating Input 3 only 
 

Logger Data Pane 
The Logger Data pane displays real-time readings on the 
logger, at a default sampling rate of one per second. You can 
also view the logger’s general status. Use the Logger Data 
pane to verify your logger is properly calibrated.  
The Calibration dialog will enable either Two-point or Offset 
calibration, or both, depending on the sensor selected. 

Note: The calibrated sensor parameters will be saved both in 
the DataNet logger and in the software memories, so there is 
no need to calibrate the logger every time you run the 
software. 

4.13.3.  Performing a Two-point 
Calibration 

To perform a two-point calibration, you must have two 
reference points to input against the real logger sensor 
values.  
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Figure 42: Two-point calibration window 
 
1. In the Point #1 field, enter the first Reference Value and 

the corresponding Logger Value.  
2. In the Point #2 field, enter the second Reference Value 

and the corresponding Logger Value.  

Note: If you are using a calibrator and the logger is currently 
displaying the real value to be calibrated, press the Copy 
button to copy the real value to the Logger Value text box. 

3. Press Send Calibration to send these values to the 
logger memory.  

4. Compare the real value in the Logger Data pane to the 
reference value. If the values are within an acceptable 
margin of error you may close the Calibration window, or 
move on to the next sensor or input. 

5. If the values are still not accurate enough, you can 
perform Offset calibration to tweak with values further. 

Note: Fourier strongly recommends calibrating using the 
default Reference values that appear in the two Reference 
value text boxes for each sensor. 
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4.13.4.  Performing an Offset 
Calibration 

If, after the Two-point calibration procedure, the logger still 
exhibits some offset value use the Offset calibration tool to 
correct it. 
The offset value is the difference between the value displayed 
by the DataNet logger and the reference value. For example if 
the calibrator is set to 0 °C and the logger reads 1 °C the 
offset value is +1, but if the logger reads −1 °C then the offset 
value is −1.  
 
To perform an Offset calibration, simply select the Offset 
calibration radio button to enable the Offset text box. For 
Thermocouples you will only have the option to perform an 
Offset calibration. 
Enter the offset value in the text box and click Send 
Calibration. Continue to adjust the offset accordingly until 
satisfied with the readings. 

4.13.5.  Setting the Offset to a Specific 
Input 

After setting the offset to all inputs simultaneously, you can 
set the offset of each input separately for even better 
accuracy.  
To set the offset of a specific input: 
1. Measure two known reference values making sure to use 

the input you need to calibrate. 
2. Enter the offset value as described in section  4.13.4 

above, making sure to select the correct input number 
instead of All. 
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3. You can repeat the procedure for every input. 

4.13.6. Calibrating the Internal PT-100 
Sensor 

Calibration of the internal PT-100 sensor on the DNL910 
logger is performed by calibrating the external PT-100 input. 
i.e. two-point calibration followed by offset calibration. 
1. In the Calibration dialog, select PT-100 in the Sensor 

drop-down menu and select All inputs.  
2. Press Setup to proceed.  
3. Connect a calibrator or an actual PT-100 sensor to Input-

1. Calibrate the input using the reference values. 
Once this calibration procedure is complete both the logger’s 
internal temperature sensor (PT-100) and external PT-100 
inputs will be calibrated. 

4.13.7.  Saving Calibration Settings 

At any time you may manually save the logger’s calibration 
settings locally to your PC.  
1. Open the logger context menu, select Calibration > Save 

Calibration and enter the password to access this 
feature. 

2. The Save As dialog will open. Name the calibration file 
(with extension .dcf) and save it either in the default 
Calibration folder in the DataNet directory or in a folder of 
your choice.  
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4.13.8.  Loading Calibration Settings 

You can load a previously saved DataNet .dcf calibration file 
at any time to restore a logger’s restore specific calibration 
settings. 
1. Open the logger context menu, select Calibration > Load 

Calibration and enter the password to access this 
feature. 

2. In the Open dialog, browse to the calibration file you need 
and click Open. The logger will be updated with the new 
calibration settings. 

4.14. Analyzing the Data 

When in offline (History View) or online data displays, you 
have a number of features for analyzing the on-screen data. 
The features for analyzing data while in the graph display are 
practically the when in offline or online mode. 

4.14.1.  Using the Graph Features 

The following section explains how to use the numerous 
graph analysis features, including an overview of the graph 
toolbar options. 
Please first refer to section  4.2.5: DataNet Toolbar Icons on 
page 66 for a full overview of the graph toolbar. 
 

Autoscaling 

Click Autoscale  on the graph toolbar to view the full data 
display, thereby restoring the axis range to its default settings. 
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Zooming 
To zoom in to a specific area of the graph: 

1. Click Zoom in  on the graph toolbar. 
2. Drag the cursor diagonally to select the area you want to 

magnify. Release the mouse button to zoom in to the 
selected area. 

3. Click Zoom in  a second time to disable the zoom 
tool. 

4. Click Autoscale to restore the default display. 

Panning 

Use the Pan tool  to pan along the x or y axis or after 
zooming in, to see any part of the graph that is outside the 
zoomed area. 

1. Click Pan  on the graph toolbar, then click anywhere 
on the graph and drag the mouse to view another area. 

2. Click the Pan icon a second time to disable the Pan tool. 
 

The Cursor 
You can display up to two cursors on the graph 
simultaneously. 
Use the first cursor to display individual data recording values. 
Use two cursors to display the difference between two 
coordinate values, to display the frequency of periodic data or 
to select a range of data points. 
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Figure 43: Example of using two cursors 
 
To display the first cursor: 

Click 1st Cursor  on the graph toolbar. You can drag the 
cursor with the mouse onto any other point on the plot, or onto 
a different plot. For finer cursor movements use the forward 
and backward keys on the keyboard.  
The coordinate values of the selected point will appear in the 
information bar at the bottom of the graph window. 
 
To display the second cursor: 

Click 2nd Cursor  and drag the cursor with the mouse onto 
any other point on the plot. The information bar will now 
display the difference between the two coordinate values. 
 
To remove the cursors: 
Click the cursor icons a second time. 
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Copying the Graph 

Click the Copy Graph icon  to copy the graph to the 
clipboard, and paste it into another application, such as a 
word processing or spreadsheet application. 
 

Displaying Alarm Levels 
Open the Alarm drop-down menu and select the relevant 
sensor to display its alarm levels.  

 
 

The Stretch/Compress Axis Tool 
Move the cursor onto one of the graph axes. The cursor icon 
changes to the double arrow symbol (↔), indicating that you 
can stretch or compress the axis scale. Drag the cursor to the 
desired location. Repeat the procedure for the other axis if 
necessary. 
To select a data set to display on the Y-axis, click on the data 
set’s name in the Y-axis list. To display more than one curve, 
click on the data sets you want. 
 

Formatting the Graph  
You can change the plot line’s color and width. The color of 
the Y-axis matches the corresponding plot’s color and will 
automatically change with any change made to the color of 
the corresponding plot.  

1. Click Graph properties  on the graph toolbar to open 
the Graph properties dialog box. 
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2. Select the Style tab, and unselect the Use system line 
properties checkbox.  

3. Select the axis you want to format in the Axis drop-down 
menu. 

4. Select the color and line width.  
5. Click OK. 
6. To restore the default formatting, select the Use system 

line properties checkbox again.  

 

Manual Scaling 

1. Click Graph properties  on the graph toolbar to open 
the Graph properties dialog. 

2. Select the Axis Scaling tab and with the Group plots by 
units checkbox unselected, select the axis to manually 
scale from the drop-down menu e.g. Date & Time axis.  

3. Uncheck the Autoscale check box and enter the custom 
values in the text box i.e. a time range, in the case of the 
Time & Date axis, or a set of values. 

4. Click OK. 
5. To restore auto scaling select the Autoscale checkbox.  
 
Manual Scaling - Grouping Plots by Unit 
You may choose to group all of the sensors measuring the 
same unit, to the same scale. For example, if you have 
several temperature sensors in your data set, all measuring 
Celsius, you can apply a common scale when displaying the 
data from these sensors. 

1. Click Graph properties  on the graph toolbar to open 
the Graph properties dialog. 
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2. Select the Axis Scaling tab and select the Group plots 
by units checkbox. 

3. In the Axis drop-down menu select the unit by which you 
wish to group the plots.  

4. Uncheck the Autoscale check box and enter the custom 
values in the text box.  

5. Click OK. 
6. To restore auto scaling select the Autoscale checkbox.  

 
Figure 44: Grouping plots by units 

4.14.2.  Statistical Analysis 

DataNet also provides some basis statistics regarding the 
open data sets. While in History View or online Data Display 
view, click the Statistics tab.  
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For each of the sensors in the data set, you will have the 
following statistics displayed: 
• Minimum / Maximum values 
• Average value 
• Number of samples 
You will also see the Logger name and SN, as well as the 
start and end time of the statistics data range. 
While in online mode these statistics are updated in real-time. 

 

4.15. Exporting Data to Excel or 
CSV Formats 

DataNet supports exporting data to Excel or CSV file formats 
(CSV stands for comma separated values).  

To export to Excel, click Export to Excel  in the online or 
offline lower graph toolbar, or go to Analysis > Export to 
Excel (while viewing data in History View). The data currently 
displayed on the graph is exported. Data from more than one 
data logger may be exported simultaneously.  
DataNet will then open a new Excel workbook displaying the 
data as well as other pertinent information such as logger 
comment, serial number and the alarm level setup. Data that 
exceeds any of the alarm levels will be indicated. 
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Figure 45: Example of data exported to Excel 
 
Only offline data opened in History View can be exported to 
CSV and is available under the Analysis menu.  

4.16. Printing the Data 

You are able to print data by clicking the Print icon  from 
the lower toolbar in Graph, Table or Statistics tabs of the 
offline or online data displays. Clicking the Print icon will open 
the Print Setup dialog where you will need to select the 
printer to print to. 
When printing a table, you can select the specific data range 
you wish to print. You are able to adjust the date and time in 
order to narrow the data range. 
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Figure 46: Printing a table 
 

4.17. Uploading Firmware 

Another of DataNet’s major features is the ability to update of 
all DataNet hardware over the air. This means that without 
moving one unit out of position in the network, the user can 
send a new firmware file to all of the data logger end units, 
Repeaters and even to the Receiver. 
This has huge benefits for both the manufacturer, Fourier, in 
pushing out new firmware releases en masse to its customers 
and also for the customer who no longer has to wait many 
business days to ship units back to the factory for upgrading. 

4.17.1.  Downloading the Firmware File 

1. In order to upgrade the firmware, the user must download 
the latest release from the Fourier Download Center at 
www.fouriersystems.com/support/download_center.php.  

2. Once the file is downloaded, it must be saved to the 
DataNet default directory. 

3. Firmware can be updated one of two ways: 
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a. Via the Update Center 
b. Directly from the unit’s icon in the Map View. Each 

unit (logger, Receiver, Repeater) has an Update 
Firmware option in the icon context menu. 

4.17.2.  Firmware Update from the 
Update Center 

1. With the firmware file is in the DataNet directory go to 
Tools > Update Center from the main menu.  

2. Enter the password in the Password dialog to access the 
Update Center. 

Note: The default password is 1234. 

3. The Update Center dialog lists all units in the network and 
will display the firmware update status.  

 
Figure 47: Update Center dialog 
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The unit comment, SN, firmware version, stack version 
and status is displayed. 

4. If the status is Requires an update, then select the 
checkbox in the Update column adjacent to the unit you 
wish to update. You may select as many units as you like 
to update, but remember the more units you select the 
slower the update will be. 

5. As soon as you select the Update checkbox, the 
command will be sent to the unit to begin uploading the 
firmware. The firmware is first uploaded to the unit’s 
memory and then installed. Even if the update is stalled 
halfway due to the unit shutting down, for example, the 
unit will not lose its current firmware and so will continue 
to be operable.  

6. When the upload begins the Update Center status will 
change to Waiting to upload firmware and the unit 
display will read Loading firmware. The progress will 
also be displayed on both hardware and software. 

 
7. When the upload is complete the unit will reset itself, the 

Update Center will display the status No update required 
and the firmware and stack versions will both be updated 
as well. 

Note: You can quit the firmware update at any time by 
unselecting the Update checkbox in the Update Center. 
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4.17.3.  Firmware Update from the Map 
View Icon 

Each DataNet unit, the data logger, Receiver and Repeater, 
has the Update Firmware option in its Map View icon context 
menu.  
1. To perform a direct update from a specific unit, open the 

context menu and select Update Firmware. 
2. Enter the password in the Password dialog box. 
3. A DataNet system message will prompt you to confirm the 

update. Click Yes. 
4. The firmware will begin updating and you can monitor its 

progress in the unit’s tooltip. 

 

4.18. System Password 

Throughout the software you will be required to enter a 
password to perform certain functions such as calibration or 
firmware update.  

Note: The default password is 1234. 

 
To change the password: 
1. In the Password dialog box, click Change Password to 

open the Change Password dialog box. 
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2. Enter the current password in the Current Password text 
box. 

3. Enter the new password in the New Password text box. 
4. Enter the new password a second time in the Confirm 

New Password text box to confirm your new password. 
5. Click OK. 

Note: The password must include at least 4 characters and is 
case sensitive. 
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Appendix A:  
DataNet Specifications 

Data Logger Inputs 
External Inputs 
Four external inputs with 
selectable sensor type for 
each input:  
• 4 to 20 mA 
• 0 to 1 V 
• 0 to 50 mV 
• PT-100 (2-wire) 
• Thermocouple J, K or T 
• Pulse counter (Input 4 

only) 
• Frequency (Input 4 only)  
• User-defined sensors 

Internal Inputs 
• Logger PN: DNL920 

 Digital Temperature 
 Digital Relative 

Humidity 
• Logger PN: DNL910 

 PT-100 
Temperature 
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Sensor Specifications 
Internal PT-100 

Temperature 
Internal Digital 
Temperature 

Internal Digital  
Relative Humidity 

• Type: PT-100 
• Range: -20 to 50 ˚C 
• Resolution: 0.1 ˚C  
• Accuracy: ±0.3 ˚C 

• Type: Digital sensor 
• Range: -20 to 50 ˚C 
• Resolution: 0.1 ˚C  
• Accuracy: ±0.5 ˚C 

• Range: 5 to 95 % 
• Resolution: 0.5% 
• Accuracy:  

3% (DataNet 
software) 
4% (Logger LCD) 

Temperature 
Thermocouple J 

Temperature 
Thermocouple K 

Temperature 
Thermocouple T 

• Range: -200 to 1,000 
˚C 

• Resolution: 0.1 ˚C  
• Accuracy: 

-200 to - 60 ˚C ±0.5 
% 
60 to 1,000 ˚C ±0.5 
% 
-60 to 60 ˚C ±0.3 ˚C 

• Cold junction 
compensation: ±0.3 
˚C 

• Range: -200 to 1,000 
˚C 

• Resolution: 0.1 ˚C  
• Accuracy:  

-200 to - 60 ˚C ±0.5 
% 
60 to 1,000 ˚C ±0.5 
% 
-60 to 60 ˚C ±0.5 ˚C 

• Cold junction 
compensation: ±0.3 
˚C 

• Range: -200 to 400 
˚C 

• Resolution: 0.1 ˚C  
• Accuracy:  

-200 to - 60 ˚C ±0.5 
% 
60 to 400 ˚C ±0.5 % 
-60 to 60 ˚C ±0.3 ˚C 

• Cold junction 
compensation: ±0.3 
˚C 
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Temperature PT-100 
(2-wire) 

Pulse Counter  
(Input 4 only) 

Frequency  
(Input 4 only) 

• Range: -200 to 400 
˚C 

• Resolution: 0.1 ˚C) 
• Accuracy:  

-200 to - 60 ˚C ±0.5 
% 
60 to 400 ˚C ±0.5 % 
-60 to 60 ˚C ±0.3 ˚C 

• Zero crossing 
detector 

• Range: 1 to 65,536 
counts 

• Resolution: 1 count 
• Frequency range: 0 

to 4 KHz 
• Input signal: 0 to 5 V 
• Input impedance: 

470 Ω  

• Zero crossing 
detector 

• Range: 20 Hz to 4 
KHz 

• Input signal: 0 to 5 V 
• Input impedance: 

470 Ω 
 
 

4 to 20 mA 0 to 1 V 0 to 50 mV 

• Range: 4 to 20 mA 
• Resolution: 0.47 μA 
• Accuracy: ±0.5 % 
• Loop impedance: 21 

Ω 
• Maximum load: 30 

mA, 5.2 V 
 

• Range: 0 to 1 V 
• Resolution: 200 μV 
• Accuracy: ±0.5 % 
• Input impedance: 25 

MΩ 
• Maximum voltage: 

5.2 V 

• Range: 0 to 50 mV 
• Resolution: 3 μV 
• Accuracy: ±0.5 % 
• Input impedance: 25 

MΩ 
• Maximum voltage: 

5.2 V 
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Data Logger Output     
Alarm Output (Output 1) External Power Excitation 

(transducers usage) 

• Open collector 
• Close position resistance: 50 Ω 
• Max. Load: 50 mA, 3 V DC 
• Overload protection 
• 50 mA reset fuse 

12 VDC @ 2 A 

 

General Hardware Specifications 
Specifications below refer to both Receiver/Repeater and 
Data Logger units unless specified. 
 

Data Logger Sampling Features Receiver PC Communication 
USB 2.0 compliance 
Receiver USB Cable Type 
Mini USB type B 
LCD Screen 

• 2 row LCD 
• 16 characters display 

Dimensions 
10 x 9.5 x 3 cm 
Weight 
200 gr 
Water and dust proof  

• Analog to Digital converter 
• 16-bit sampling resolution 
• Memory capacity: ~60,000 samples 
• Sampling rate: From 1 sample per 

sec to 1 sample per 2 hours 
• Transmission rate: From 1 sample 

per sec to 1 sample per 2 hours 
• Channel separation: 80 dB 

IP54 
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Power Supply RF Transmission 

• External Power: 12 V ext DC adapter 
and 2 x 2.4 V rechargeable battery 
pack 

• Battery voltage range: 4 V to 4.8 V 
(two rechargeable battery packs in 
series) 

• Battery type: 4 cells of 800 mA NiMh 
(2.8V, 1600 mA) 

• Battery  charging cycles: After 400 
cycles the battery will have charging 
capability of 80% 

• Data Logger battery life: 6 months 
at sampling rate of once every five 
minutes and transmission rate of once 
every ten minutes 

• Receiver/Repeater battery life: Up 
to three hours 

• External 12 – 15 V DC input @ 300 
mA 3.6 VA 

• Frequency: 2.4 GHz 
• Network units: ~65,000 
• Data rate: 250 Kbps 
• Full mesh network architecture 

supported 
• 128-bit network security 

inscription 
• Worldwide free license 
• Data Logger: RF Transmission 

range boost mode of 80 m (line of 
sight) 

• Receiver/Repeater: RF 
Transmission range power 
amplifier 800 m (line of sight) 

Standards Compliance Operating Temperature Range 

CE, FCC -20 to 50 °C 

Mounting Casing 

Wall mounting Plastic ABS box 
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System Requirements 
Software Hardware 

• OS Platform: Windows 2000 SP3, 
Windows 2003, Windows XP SP2, 
and Windows Vista 

• Browser: Internet Explorer 5.01 or 
higher 

• Processor: Pentium 800 MHz or 
higher  

• Memory: 256 MB RAM  
• Storage Memory: 250 MB 

available disk space for the 
DataNet application 
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Appendix B:  
Ordering Information 

To order Fourier Systems products please visit: 
www.fouriersystems.com/order 

DataNet Product Suite 
Part Number Product Name Product Description 

DNR900 

 

Receiver/Repeater Module for creating and 
managing DataNet ZigBee 
network 

DNL910 

 

Data Logger  • Internal Temperature PT-
100 sensor 

• Four channels: mA, V, mV, 
TC-K/J/T, PT-100, Pulse, 
Frequency 

DNL920 

 

Data Logger • Internal Digital RH and 
Temperature sensors 

• Four channels: mA, V, mV, 
TC-K/J/T, PT-100, Pulse, 
Frequency 
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DN-PCSUITE 

 

 

Software CD and 
Accessories 

PC Suite including USB 
communication cable, software 
CD and user guide 

12753 

 

PT-100 temperature 
sensor and cable 

PT-100 temperature sensor 
with 2.5 m cable  
 

12752 

 

PT-100 temperature 
sensor and cable 

PT-100 temperature sensor 
with 4 m cable  
 

12751 

 

PT-100 temperature 
sensor and cable 

PT-100 temperature sensor 
with 6 m cable  
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